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Legal and Compliance Statements
Intellectual Property and Regulatory Notices
Copyrights
The Motorola Solutions products described in this document may include copyrighted Motorola Solutions
computer programs. Laws in the United States and other countries preserve for Motorola Solutions
certain exclusive rights for copyrighted computer programs. Accordingly, any copyrighted Motorola Solutions
computer programs contained in the Motorola Solutions products described in this document may not be
copied or reproduced in any manner without the express written permission of Motorola Solutions.
No part of this document may be reproduced, transmitted, stored in a retrieval system, or translated into
any language or computer language, in any form or by any means, without the prior written permission of
Motorola Solutions, Inc.

Trademarks
MOTOROLA, MOTO, MOTOROLA SOLUTIONS, and the Stylized M Logo are trademarks or registered
trademarks of Motorola Trademark Holdings, LLC and are used under license. All other trademarks are the
property of their respective owners.

License Rights
The purchase of Motorola Solutions products shall not be deemed to grant either directly or by implication,
estoppel or otherwise, any license under the copyrights, patents or patent applications of Motorola Solutions,
except for the normal nonexclusive, royalty-free license to use that arises by operation of law in the sale of a
product.

Open Source Content
This product may contain Open Source software used under license. Refer to the product installation media
for full Open Source Legal Notices and Attribution content.

European Union (EU) and United Kingdom (UK) Waste of Electrical and Electronic
Equipment (WEEE) Directive

 The European Union's WEEE directive and the UK's WEEE regulation require that products sold into
EU countries and the UK must have the crossed-out wheelie bin label on the product (or the package in some
cases). As defined by the WEEE directive, this crossed-out wheelie bin label means that customers and end
users in EU and UK countries should not dispose of electronic and electrical equipment or accessories in
household waste.
Customers or end users in EU and UK countries should contact their local equipment supplier representative
or service center for information about the waste collection system in their country.

Disclaimer
Please note that certain features, facilities, and capabilities described in this document may not be applicable
to or licensed for use on a specific system, or may be dependent upon the characteristics of a specific mobile
subscriber unit or configuration of certain parameters. Please refer to your Motorola Solutions contact for
further information.
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© 2024 Motorola Solutions, Inc. All Rights Reserved

Computer Software Copyrights
The products described in this manual include copyrighted Futurecom computer programs stored in
semiconductor memories or other media. Laws in the United States, Canada, and other countries
preserve for Futurecom certain exclusive rights for copyrighted computer programs, including but not
limited to, the exclusive right to copy or reproduce in any form the copyrighted computer programs. Any
copyrighted computer program contained in the Futurecom products described in this manual may not be
copied, reproduced, modified, reverse-engineered, or distributed in any manner without the express written
permission of Futurecom. The purchase of Futurecom products shall not be deemed to grant either directly
or by implication, estoppels, or otherwise, any license under the copyrights, patents, or patent applications of
Futurecom, except for the normal non-exclusive license to use that arises by operation of law in the sale of a
product.

Publicly Available Software List
The Futurecom Repeater Configurator provided by Futurecom Systems Group ULC includes the following
Publicly Available Software.

MFC Grid Control
Version

2.24
Modified

Yes
Software Site

http://www.codeproject.com/KB/miscctrl/gridctrl.aspx
Source Code

No Source Code Distribution Obligations. The Source Code may be obtained from the original Software
Site.

License
The Article associated with the Source Code is licensed under the Code Project Open License (CPOL),
version 1.02. Reference the Common Licenses Section for the terms of the CPOL. The Source Code
licensed is under Custom Freeware/Open Source Software License, see below:
Written by Chris Maunder <chris@codeproject.com>
Copyright (c) 1998-2002. All Rights Reserved.
This code may be used in compiled form in any way you desire. This file may be redistributed unmodified
by any means PROVIDING it is not sold for profit without the authors written consent, and providing that
this notice and the authors name and all copyright notices remains intact.
An email letting me know how you are using it would be nice as well.
This file is provided "as is" with no expressed or implied warranty.
The author accepts no liability for any damage/loss of business that this product may cause.

Additional Notices
CInPlaceEdit, http://www.codeguru.com/listview/edit_subitems.shtml, licensed under the CodeGuru
License.
Refer to Common Licenses on page 4 for the terms of the CodeGuru License.

Credits
Zafir Anjum
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Eric Woodruff
Ken Bertelson
Joe Willcoxson

Common Licenses

The Code Project Open License (CPOL) 1.02
Preamble

This License governs Your use of the Work. This License is intended to allow developers to use the
Source Code and Executable Files provided as part of the Work in any application in any form.
The main points subject to the terms of the License are:
● Source Code and Executable Files can be used in commercial applications.
● Source Code and Executable Files can be redistributed; and
● Source Code can be modified to create derivative.
● No claim of suitability, guarantee, or any warranty whatsoever is provided. The software is provided

"as-is".
● The Article accompanying the Work may not be distributed or republished without the Author's

consent.
This License is entered between You, the individual or other entity reading or otherwise making use of the
Work licensed pursuant to this License and the individual or other entity which offers the Work under the
terms of this License ("Author").

License
THE WORK (AS DEFINED BELOW) IS PROVIDED UNDER THE TERMS OF THIS CODE PROJECT
OPEN LICENSE ("LICENSE"). THE WORK IS PROTECTED BY COPYRIGHT AND/OR OTHER
APPLICABLE LAW. ANY USE OF THE WORK OTHER THAN AS AUTHORIZED UNDER THIS LICENSE
OR COPYRIGHT LAW IS PROHIBITED.
BY EXERCISING ANY RIGHTS TO THE WORK PROVIDED HEREIN, YOU ACCEPT AND AGREE
TO BE BOUND BY THE TERMS OF THIS LICENSE. THE AUTHOR GRANTS YOU THE RIGHTS
CONTAINED HEREIN IN CONSIDERATION OF YOUR ACCEPTANCE OF SUCH TERMS AND
CONDITIONS. IF YOU DO NOT AGREE TO ACCEPT AND BE BOUND BY THE TERMS OF THIS
LICENSE, YOU CANNOT MAKE ANY USE OF THE WORK.
1. Definitions.

a. "Articles" means, collectively, all articles written by Author which describes how the Source Code
and Executable Files for the Work may be used by a user.

b. "Author" means the individual or entity that offers the Work under the terms of this License.
c. "Derivative Work" means a work based upon the Work or upon the Work and other pre-existing

works.
d. "Executable Files" refer to the executable files, binary files, configuration, and any required data

files included in the Work.
e. "Publisher" means the provider of the website, magazine, CD-ROM, DVD or other medium from or

by which the Work is obtained by You.
f. "Source Code" refers to the collection of source code and configuration files used to create the

Executable Files.
g. "Standard Version" refers to such a Work if it has not been modified or has been modified in

accordance with the consent of the Author, such consent being in the full discretion of the Author.
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h. "Work" refers to the collection of files distributed by the Publisher, including the Source Code,
Executable Files, binaries, data files, documentation, whitepapers and the Articles.

i. "You" is you, an individual or entity wishing to use the Work and exercise your rights under this
License.

2. Fair Use / Fair Use Rights. Nothing in this License is intended to reduce, limit, or restrict any rights
arising from fair use, fair dealing, first sale or other limitations on the exclusive rights of the copyright
owner under copyright law or other applicable laws.

3. License Grant. Subject to the terms and conditions of this License, the Author hereby grants You a
worldwide, royalty-free, non-exclusive, perpetual (for the duration of the applicable copyright) license
to exercise the rights in the Work as stated below:
a. You may use the standard version of the Source Code or Executable Files in Your own

applications.
b. You may apply bug fixes, portability fixes and other modifications obtained from the Public Domain

or from the Author. A Work modified in such a way shall still be considered the standard version
and will be subject to this License.

c. You may otherwise modify Your copy of this Work (excluding the Articles) in any way to create
a Derivative Work, if you insert a prominent notice in each changed file stating how, when and
where You changed that file.

d. You may distribute the standard version of the Executable Files and Source Code or Derivative
Work in aggregate with other (possibly commercial) programs as part of a larger (possibly
commercial) software distribution.

e. The Articles discussing the Work published in any form by the author may not be distributed or
republished without the Author's consent. The author retains copyright to any such Articles. You
may use the Executable Files and Source Code pursuant to this License, but you may not repost
or republish or otherwise distribute or make available the Articles, without the prior written consent
of the Author.

Any subroutines or modules supplied by You and linked into the Source Code or Executable Files of
this Work shall not be considered part of this Work and will not be subject to the terms of this License.

4. Patent License. Subject to the terms and conditions of this License, each Author hereby grants to
You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as stated in
this section) patent license to make, have made, use, import, and otherwise transfer the Work.

5. Restrictions. The license granted in Section 3 above is expressly made subject to and limited by the
following restrictions:
a. You agree not to remove any of the original copyright, patent, trademark, and attribution notices

and associated disclaimers that may appear in the Source Code or Executable Files.
b. You agree not to advertise or in any way imply that this Work is a product of Your own.
c. The name of the Author may not be used to endorse or promote products derived from the Work

without the prior written consent of the Author.
d. You agree not to sell, lease, or rent any part of the Work. This does not restrict you from including

the Work or any part of the Work inside a larger software distribution that itself is being sold. The
Work by itself, though, cannot be sold, leased or rented.

e. You may distribute the Executable Files and Source Code only under the terms of this License,
and You must include a copy of, or the Uniform Resource Identifier for, this License with every
copy of the Executable Files or Source Code You distribute and ensure that anyone receiving such
Executable Files and Source Code agrees that the terms of this License apply to such Executable
Files and/or Source Code. You may not offer or impose any terms on the Work that alter or restrict
the terms of this License or the recipients' exercise of the rights granted hereunder. You may
not sublicense the Work. You must keep intact all notices that refer to this License and to the

MN010432A01-AA
Legal and Compliance Statements

5



disclaimer of warranties. You may not distribute the Executable Files or Source Code with any
technological measures that control access or use of the Work in a manner inconsistent with the
terms of this License.

f. You agree not to use the Work for illegal, immoral or improper purposes, or on pages containing
illegal, immoral or improper material. The Work is subject to applicable export laws. You agree
to comply with all such laws and regulations that may apply to the Work after Your receipt of the
Work.

6. Representations, Warranties and Disclaimer. THIS WORK IS PROVIDED "AS IS", "WHERE
IS" AND "AS AVAILABLE", WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES OR
CONDITIONS OR GUARANTEES. YOU, THE USER, ASSUME ALL RISK IN ITS USE,
INCLUDING COPYRIGHT INFRINGEMENT, PATENT INFRINGEMENT, SUITABILITY, ETC.
AUTHOR EXPRESSLY DISCLAIMS ALL EXPRESS, IMPLIED OR STATUTORY WARRANTIES
OR CONDITIONS, INCLUDING WITHOUT LIMITATION, WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, MERCHANTABLE QUALITY OR FITNESS FOR A PARTICULAR PURPOSE,
OR ANY WARRANTY OF TITLE OR NON-INFRINGEMENT, OR THAT THE WORK (OR ANY
PORTION THEREOF) IS CORRECT, USEFUL, BUG-FREE OR FREE OF VIRUSES. YOU MUST
PASS THIS DISCLAIMER ON WHENEVER YOU DISTRIBUTE THE WORK OR DERIVATIVE
WORKS.

7. Indemnity. You agree to defend, indemnify and hold harmless the Author and the Publisher from and
against any claims, suits, losses, damages, liabilities, costs, and expenses (including reasonable legal
or attorneys’ fees) resulting from or relating to any use of the Work by You.

8. Limitation on Liability. EXCEPT TO THE EXTENT REQUIRED BY APPLICABLE LAW, IN NO
EVENT WILL THE AUTHOR OR THE PUBLISHER BE LIABLE TO YOU ON ANY LEGAL THEORY
FOR ANY SPECIAL, INCIDENTAL, CONSEQUENTIAL, PUNITIVE OR EXEMPLARY DAMAGES
ARISING OUT OF THIS LICENSE OR THE USE OF THE WORK OR OTHERWISE, EVEN IF THE
AUTHOR OR THE PUBLISHER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

9. Termination.
a. This License and the rights granted hereunder will terminate automatically upon any breach by

You of any term of this License. Individuals or entities who have received Derivative Works from
You under this License, however, will not have their licenses terminated provided such individuals
or entities remain in full compliance with those licenses. Sections 1, 2, 6, 7, 8, 9, 10 and 11 will
survive any termination of this License.

b. If You bring a copyright, trademark, patent, or any other infringement claim against any contributor
over infringements You claim are made by the Work, your License from such contributor to the
Work ends automatically.

c. Subject to the above terms and conditions, this License is perpetual (for the duration of the
applicable copyright in the Work). Notwithstanding the above, the Author reserves the right to
release the Work under different license terms or to stop distributing the Work at any time;
provided, however that any such election will not serve to withdraw this License (or any other
license that has been, or is required to be, granted under the terms of this License), and this
License will continue in full force and effect unless terminated as stated above.

10. Publisher. The parties hereby confirm that the Publisher shall not, under any circumstances, be
responsible for and shall not have any liability in respect of the subject matter of this License. The
Publisher makes no warranty whatsoever in connection with the Work and shall not be liable to You
or any party on any legal theory for any damages whatsoever, including without limitation any general,
special, incidental or consequential damages arising in connection to this license. The Publisher
reserves the right to cease making the Work available to You at any time without notice.

11. Miscellaneous.
a. This License shall be governed by the laws of the location of the head office of the Author or if the

Author is an individual, the laws of location of the principal place of residence of the Author.
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b. If any provision of this License is invalid or unenforceable under applicable law, it shall not affect
the validity or enforceability of the remainder of the terms of this License, and without further
action by the parties to this License, such provision shall be reformed to the minimum extent
necessary to make such provision valid and enforceable.

c. No term or provision of this License shall be deemed waived, and no breach consented to unless
such waiver or consent shall be in writing and signed by the party to be charged with such waiver
or consent.

d. This License constitutes the entire agreement between the parties with respect to the Work
licensed herein. There are no understandings, agreements, or representations with respect to the
Work not specified herein. The Author shall not be bound by any additional provisions that may
appear in any communication from You. This License may not be modified without the mutual
written agreement of the Author and You.

CodeGuru License
http://www.codeguru.com/submission-guidelines.php#permission
As you know, this site is a valuable resource for the developer community. Please note, however, that
to avoid legal complications, we need to obtain your permission to use any computer code and any
related materials ("resources") that you are providing to us. Accordingly, by submitting any such resource
to CodeGuru, you grant to QuinStreet a nonexclusive, worldwide, perpetual license to reproduce, distribute,
adapt, perform, display, and sublicense the submitted resource (in both object and source code formats,
as well as on and off the Web), and you acknowledge that you have the authority to grant such rights to
QuinStreet.
By submitting the resource, you also grant your article's readers the permission to use any source code in the
resource for commercial or noncommercial software. PLEASE NOTE THAT YOU RETAIN OWNERSHIP OF
ANY COPYRIGHTS IN ANY RESOURCES SUBMITTED!
ALSO, IN MAKING THE RESOURCE AVAILABLE TO OTHER SITE VISITORS FOR DOWNLOADING,
QUINSTREET WILL INFORM SUCH OTHER VISITORS THAT, ALTHOUGH THEY MAY DOWNLOAD ANY
RESOURCES FOR COMMERCIAL OR NONCOMMERCIAL USES, THEY MAY NOT REPUBLISH THE
SOURCE CODE SO THAT IT IS ACCESSIBLE TO THE PUBLIC WITHOUT FIRST OBTAINING THE
COPYRIGHT OWNER'S PERMISSION.

Commercial Warranty
Please reference Futurecom Terms and Conditions of Sale, Section 7 regarding standard warranty.
(Futurecom website → Terms and Conditions)

Declaration of Conformity
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference when the equipment is operated in a commercial environment. This equipment generates, uses,
and can radiate radio frequency energy and, if not installed and used in accordance with the instruction
manual, may cause harmful interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation.
Changes or modifications not expressly approved by Futurecom Systems Group, ULC. could void the User’s
authority to operate the equipment.

Déclaration de Conformité
Cet équipement a été testé et déclaré conforme aux limites pour appareils numériques de classe A, selon la
partie 15 des règlements de la FCC. Ces limites sont destinées à assurer une protection raisonnable contre
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les interférences nuisibles dans une installation commerciale. L’équipement génère, utilise et peut émettre de
l’énergie de fréquence radio et peut causer des interférences nuisibles aux communications radio s’il n’est
pas installé ou utilisé conformément au mode d’emploi. Toutefois, rien ne garantit l’absence d’interférences
dans une installation particulière.
Les changements et les modifications qui n’ont pas été approuvés expressément par Futurecom Systems
Group ULC pourraient faire perdre à l’utilisateur son droit à utiliser cet équipement.

Important Safety Information
The PDR8000® is intended for use in occupational/controlled conditions, where users have full knowledge of
the operator exposure and can exercise control over the operator exposure to meet FCC/ISED limits. This
radio is NOT authorized for general population, consumer, or any other use.

Informations de Sécurité Importantes
Le PDR8000® est conçu pour être utilisé dans des conditions professionnelles contrôlées, dans lesquelles
les utilisateurs connaissent à fond leur exposition et peuvent exercer le contrôle nécessaire sur celle-ci pour
se conformer aux limites de la FCC/ISED. Cette radio N’EST PAS autorisée pour être utilisée par le grand
public, les consommateurs ou autres.

Notice to Users (FCC/ISED)
To satisfy FCC/ISED RF exposure requirements for mobile transmitting devices, refer to the RF Safety
Booklet1 for TX – RX duty cycle and a separation distance between the antenna of this device and persons
during operation. To ensure compliance, operations at closer than this distance is not allowed.
Futurecom requires the P25 DVRS operator to ensure FCC/ISED Requirements for Radio Frequency
Exposure are met. The minimum distance between all possible personnel and the body of the DVRS
equipped vehicle is specified in the RF Safety Booklet1. Failure to observe the Maximum Permissible
Exposure (MPE) distance exclusion area around the antenna may expose persons within this area to RF
energy above the FCC exposure limit for bystanders (general population).
It is the responsibility of the repeater operator to ensure that MPR limits are always observed during repeater
transmissions. The repeater operator must always ensure that no person comes within MPE distance from
the antenna.

Avis Aux Utilisateurs (FCC/ISED)
Pour satisfaire les exigences de la FCC / ISED en matière d’exposition à l’énergie RF pour les transmetteurs
mobiles, prière de consulter la Brochure Sécurité RF1 pour obtenir le facteur d’utilisation transmission /
réception et la distance de séparation entre l’antenne de cet appareil et les personnes pendant l’utilisation.
Pour assurer la conformité, le fonctionnement à une distance moins élevée n’est pas autorisé.
Futurecom demande à l’opérateur du répéteur P25 DVRS de satisfaire aux exigences de la FCC/ISED
en matière d’exposition à l’énergie RF. La distance minimale entre toutes les personnes possibles et une
antenne omnidirectionnelle doit respecter les indications de la Brochure Sécurité RF1. Tout manquement
à respecter la zone d’exclusion autour de l’antenne définie par la distance correspondant à la limite
d’exposition maximale peut exposer les personnes qui se trouvent dans ce rayon à une énergie RF
supérieure à la limite d’exposition de la FCC pour les spectateurs (population générale).
C’est à l’opérateur du répéteur qu’il incombe de s’assurer que les limites d’exposition maximales sont
respectées en tout temps pendant les transmissions du répéteur. L’opérateur du répéteur doit s’assurer en

1 Refer to the manuals Product Safety and RF Energy Exposure Booklet for PDR8000 (publication
number MN010431A01) and Product Safety and RF Energy Exposure Booklet for Booster Pack
(publication number MN010430A01).
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tout temps que personne ne s’approche de l’antenne à une distance inférieure à celle correspondant à la
limite d’exposition minimale.
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Contact Us
The Centralized Managed Support Operations (CMSO) is the primary contact for technical support included
in your organization's service agreement with Motorola Solutions. To enable faster response time to customer
issues, Motorola Solutions provides support from multiple countries around the world.
Service agreement customers should be sure to call the CMSO in all situations listed under Customer
Responsibilities in their agreement, such as:
● To confirm troubleshooting results and analysis before taking action

Your organization received support phone numbers and other contact information appropriate for your
geographic region and service agreement. Use that contact information for the most efficient response.
However, if needed, you can also find general support contact information on the Motorola Solutions website,
by following these steps:
1. Enter motorolasolutions.com in your browser.
2. Ensure that your organization's country or region is displayed on the page. Clicking or tapping the name

of the region provides a way to change it.
3. Select "Support" on the motorolasolutions.com page.

Comments
Send questions and comments regarding user documentation to documentation@motorolasolutions.com.
Provide the following information when reporting a documentation error:
● The document title and part number
● The page number or title of the section with the error
● A description of the error
Motorola Solutions offers various courses designed to assist in learning about the system. For information, go
to https://learning.motorolasolutions.com to view the current course offerings and technology paths.
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Document History
Version Description Date

MN010432A01-AA Initial converted edition. May 2024
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About This Manual
The Futurecom Repeater Configurator (FRC) is the software used for all hardware programming needs.

For requirements on compatible Mobile and Portable radios, refer to the Compatibility Charts.
For details on the APX series Mobile or Portable Radios operation, refer to the applicable Manuals available
from Motorola Solutions Learning eXperience Portal (LXP) website.
FRC contains three main components to service all hardware programming needs:
1. Configurator for APX Repeaters (DVR, DVR-LX, and VRX1000)
2. Configurator for PDR8000®

3. Flash Downloader Utility (used to update the firmware of the VR)

The following table list of Firmware is the minimum requirement for the PDR8000 operation described in this
manual.

Repeater Module Firmware: 4C088X01 R5.05

Repeater Module Boot Firmware: 4C088X02 R5.04

Transceiver DSP: 4C083X03 R1.18

Baseband DSP: 4C083X04 R1.54

IF Module Firmware: 4C088X07 R5.05

IF Module Boot Firmware: 4C088X08 R5.05

Futurecom Repeater Configurator (FRC): 6V088X01 R1.40 or later

Notations Used in This Manual
This guide is designed to give you more visual cues.

The following graphic icons are used throughout the user guide.
DANGER: The signal word DANGER with the associated safety icon implies information that, if
disregarded, will result in death or serious injury.
WARNING: The signal word WARNING with the associated safety icon implies information that, if
disregarded, could result in death or serious injury, or serious product damage.
CAUTION: The signal word CAUTION with the associated safety icon implies information that, if
disregarded, may result in minor or moderate injury, or serious product damage.
CAUTION: The signal word CAUTION without the associated safety icon implies potential damage to
non-MSI equipment, software or data, or injury that is not related to the MSI product.
IMPORTANT: IMPORTANT statements contain information that is crucial to the discussion at hand, but
is not a CAUTION or WARNING. There is no warning level associated with the IMPORTANT statement.
NOTE: NOTE contains information more important than the surrounding text, such as exceptions or
preconditions. They also refer the reader elsewhere for additional information, remind the reader how to
complete an action (when it is not part of the current procedure, for instance), or tell the reader where
something is on the screen. There is no warning level associated with a notice.
TIP: TIP contains information that provides the reader a different or quicker method in accomplishing
the same task. At times, they also give the reader the best way to proceed or handle the task.
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The following special notations highlight certain information:

Table 1: Special Notations

Example Description

Menu key or PTT button Bold words indicate a name of a key, button, soft
menu item, or programming menu item.

Ordering Guide Italic word indicates title of a bibliographic re-
source.

Powering Off Typewriter words indicate the Human Machine In-
terface (HMI) strings or messages displayed on
your display.

File → Templates (DPD Files) → Load DPD Tem-
plate

Bold words with the arrow between indicate the
navigation structure in the menu items.

MN010432A01-AA
About This Manual

17



Related Publications
User Guides

Part Number Description

MN010354A01 Battery Pack and Charger User Guide

MN010433A01 PDR8000 Portable Digital Repeater Connectivity Deployment Appli-
cation Note

MN010436A01 PDR8000 Product Planner

MN010434A01 PDR8000 and Booster Pack Deployment Guide

Data Sheets
Data sheets can be retrieved from the Futurecom website. Go to Support → Documentation and Software
→ PDR8000 → Datasheets.

Model Data sheets

PDR8000® ● PDR8000 - Suitcase
● PDR8000 - Rackmount

Safety Booklets

Part Number Description

MN010430A01 Product Safety and RF Energy Exposure Booklet for Booster Pack

MN010431A01 Product Safety and RF Energy Exposure Booklet for PDR8000

Others

Publication Description

Ordering Guides Include the following guides:
● PDR8000 Ordering Guide
● PDR8000 Rackmount Ordering Guide
Ordering guides can be retrieved from the Futurecom website. Go to
Support → Documentation and Software → PDR8000 → Order-
ing Guide.
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Chapter 1

PDR8000 Programming Basics
This section gives an introduction to the basics of Portable Digital Repeater (PDR) programming on the
Futurecom Repeater Configurator (FRC).

1.1

Installation of FRC Software
The following presents the software installation and the requirements for the Futurecom Repeater
Configurator (FRC) software.
The following parameters represent the minimum hardware and software requirements for FRC.
Operating Systems

Microsoft® Windows® 10 or Windows® 11
Processor

1 GHz or higher grade Processor
Peripherals

USB port

1.1.1

Uninstalling Previous FRC
Procedure:

1. To remove any previous installation of FRC2 versions, go to Start → Settings → Apps → Installed
Apps3.

2. Find the FRC application and select on the Uninstall option.

1.1.2

Installing FRC
Procedure:

1. Download and save the Futurecom Repeater Configurator (FRC) installer.
The latest version of FRC is available on the Futurecom website. Go to Support → Documentation
and Software → PDR8000 → FRC Programming Software.

2. On the Downloads page, fill in the required fields and click on SUBMIT & DOWNLOAD.
3. Select a location to save the application, and click Save.
4. Double-click on the setup application from the saved location.
5. In the License Agreement window, select I accept the agreement and click Next.

2 Also formally known as Tweaker
3 Depending on the Operating System you are using, the steps to get to the list of Installed Applications

may differs.
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6. Select the destination location folder for the installation files and click Next.
NOTE: You can change the filepath folder for the installation.

7. Select the additional tasks to be included during the installation and click Next.
8. Click Install to start the installation.

Result: The installation starts.

1.1.3

Setting Up Communications with the PDR8000
Prerequisites:
● Ensure that the USB cable is plugged into the computer and connected to the USB port on the PDR8000.
● Ensure that the PDR8000 is powered up. Check the LED Display on the panel.

○ The Power LED and DC/Battery LED should light up in green.

Procedure:
1. On the FRC launch window, select PDR8000.

NOTE: The FRC launch window has two choices, DVR-LX/DVR/VRX1000 and PDR8000.

2. On the FRC, select Options → COM Ports.
3. In the Ports window, check if Futurecom USB modem is displayed. See Ports on page 36 for more

information.
4. If the COM Port field is blank, check the USB connection or change the USB Port on the computer.

1.1.4

Setting Optimum View of the FRC
Procedure:

For an optimum view of the FRC menu windows on the PC, ensure that the following recommended
display settings on your PC are set:
● Text size no greater than 125%.
● Use Tahoma Regular Font.
● Adjust the font size for your display and preference.

NOTE: Procedures to make these changes may differs depending on your Operating System.
Contact your administrator for further assistance.

1.2

Introduction to FRC
The Futurecom Repeater Configurator (FRC) application provides the interface for servicing the hardware
programming needs on all supported PDR8000.

Using FRC Online
To use FRC online, ensure that the following requirements are active:
1. FRC is installed on the PC.
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2. Powered up PDR8000.
3. Programming cable (USB cable) connected to PDR8000.

1.2.1

FRC Menu Bar
The FRC menu bar contains a number of options, commands, and shortcut buttons.
Figure 1: FRC Menu Bar

1.2.1.1
File Menu in FRC
The File menu in FRC contains commands for file operations, including applying, loading, and saving.

Figure 2: File Menu

The File menu contains the following elements:

Table 2: File Menu

Menu Item Dropdown Menus (Key-
board Shortcut)

Description

Templates (DPD Files) Apply DPD Template to
PDR8000

Apply, load, and save DPD files.

Save DPD Template

Load DPD Template (Ctrl +
F6)

Futurecom Support (EPR
Files)

Save EPR Support File Apply, load, and save EPR files.

Load EPR Support File (F6)

Apply Rescue File to PDR8000 Load rescue files.
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Menu Item Dropdown Menus (Key-
board Shortcut)

Description

Apply License File Load licenses.

Preferences Open the Preferences window.

Exit Exits the FRC application.

1.2.1.2
PDR Menu in FRC
The PDR menu in FRC contains commands for the PDR, including load, save, and reset.

Figure 3: PDR Menu

The PDR menu contains the following elements:

Table 3: PDR Menu

Menu Item (Keyboard Short-
cut)

Description

Load Data from PDR8000 (F2) Read data from the PDR and load to the FRC for review and editing.

Save Changes to PDR8000 (F4) Upload updated data from the FRC to the PDR.

Reset PDR8000 (F3) Reset the PDR. Usually done to ensure updates take effect.

EEprom Maintenance (Ctrl + E) Opens the EEprom maintenance window which is used for debug-
ging purposes.

Set Device Date and Time View or set date and time on the device

Configure Deployment Opens Deployment Configuration window which allows reordering,
copying, and clearing of deployments.
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1.2.1.3
Application Menu in FRC
The Application menu in the FRC log information for technical support purposes.

Figure 4: Application Menu

The Application menu contains the following elements:

Table 4: Application Menu

Menu Item Dropdown Menus Description

Log Windows RS232 Log
● Save
● Clear

Save and clear RS232 log information.

Application Log
● Show
● Save
● Clear

View, save, and clear application log information.

Status Report Lists the number of occurrences for errors, warn-
ings, and more info from the repeater (resets on
power cycle).

Status Log Lists each error, warning, and more info from the
repeater (resets on power cycle).

EEprom Log Displays errors, warnings, channel or deployment
changes, and system status.

Clear All Data Clear all log information.
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1.2.1.4
User Menu in FRC
The User menu in FRC allows user changes for technical support purposes.

Figure 5: User Menu

The User menu contains the following elements:

Table 5: User Menu

Menu Item Description

Change User Opens the Login window to log in as a different user.

1.2.1.5
Options Menu in FRC
The Options menu in the FRC allows you to make changes to the COM port.

Figure 6: Options Menu

The Options menu contains the following elements:

Table 6: Options Menu

Menu Item Description

COM Ports Opens the Ports window.

Create Support Package Creates standard support files required for the Support team to de-
bug PDR8000 issues. See Creating a Support Package on page 29.
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1.2.1.6
Help Menu in FRC
The Help menu links to support documentation and compatibility charts, and provides search functionality.

Figure 7: Help Menu

The Help menu contains the following elements:

Table 7: Help Menu

Menu Item (Keyboard
Shortcut)

Description

Help Open the online help system.

About View software version information.

Find (Ctrl + F) Find functionality provides a quick way to search through FRC for a particular
field. Enter a few letters of a field name, click FIND and results will show all
fields matching the string. Select the desired result and click GO to open that
screen.
Figure 8: Find Feature in Help Menu
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1.2.2

FRC Icons
Table 8: FRC Icons

Icon Description

Font
Allows selecting font type, style, size, color, and effects

Application Reset
Clears all data in the application memory

Save
Save changes to the file

Com Port Log
Contains communication between FRC and repeater, used for debugging

Application Log
Contains details that may be required when accessing technical support

Find
Search function by field name and/or field values

Change User Level
Used to switch between default user and admin access

EEPROM Maintenance
Used for debugging

Deployment Configuration
Allows reordering, copying, and clearing of deployments

Status Report
Lists the number of occurrences for errors, warnings, and more info from the
repeater (resets on power cycle)

Status Log
Lists each error, warning, and more info from the repeater (resets on power
cycle)

Status EEPROM Log
Displays errors, warnings, channel or deployment changes, and system status

Set Date and Time
View or set date and time on the device

Undo
Undo last action

Copy
Copy selected content

Paste
Paste selected content

Minimize/Restore
Minimize/Maximize window
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Icon Description

Help
Access Help function

1.2.3

Reading the PDR8000 Electronic Label
The Electronic Label of the PDR8000 contains information regarding the firmware currently loaded in the
PDR8000, the hardware model, and the serial number. The Electronic Label can be read either on-line or by
loading a previously saved EPR or DPD file. The information contained in the Electronic Label stored in the
DPD file does not overwrite the electronic labels of the PDR8000s during cloning.

Procedure:
To read the PDR8000 Electronic Label, from the FRC navigation tree, select PDR Configuration
→ Hardware/Software Information.

NOTE: An EPR file contains the personality and calibration data of a specific PDR8000 unit. A DPD
file contains the personality settings of a PDR8000 unit that may be used as a template to copy into
other PDR8000 units.

1.2.4

Reading from the PDR8000
This procedure uploads data from the currently connected PDR8000 to the FRC.

Procedure:
1. Establish communication with the PDR8000.
2. Perform one of the following options:

● Select PDR → Load Data from PDR8000.
● Press shortcut key F2.
A progress dialog pops up.

Result: Personality data of the currently connected PDR8000 unit will be loaded into FRC for reviewing
and/or editing.

1.2.5

Writing to the PDR8000
This procedure downloads data from the FRC to the currently connected PDR8000.

Procedure:
To write to the PDR8000, perform one of the following options:
● Applying DPD File (Cloning) on page 28
● Writing Selected Changes to the PDR8000 on page 29
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1.2.5.1
Applying DPD File (Cloning)
This action reads (uploads) data from the attached PDR8000, applies a selected DPD Template, and then
writes (downloads) the modified configuration to the PDR8000.

Procedure:
1. From the menu bar, select File → Templates (DPD Files) → Apply DPD Template to PDR8000.
2. Specify the desired DPD file name and location when prompted.
3. If an outdated DPD file is loaded, an upgrade confirmation dialog window appears.

NOTE: If there exists an outdated DPD file created with outdated versions (for example, R1.0,
R2.0, or R3.0), the FRC upgrades this file to the current DPD format prior to applying it to the
PDR8000.

4. To continue, click Yes.
Result: An upgrade completion notification is shown once the upgrade is completed.

This indicates that the program created a new file with the same name as the original file, but with the suffix:
<_v2_to_v4_updated.dpd>.

For example, if the original file was named: <Myfile.dpd>, the upgraded file would be:
<Myfile_v2_to_v4_updated.dpd>.

Click OK to close this message, and the new upgraded DPD file will be loaded.
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1.2.5.2
Writing Selected Changes to the PDR8000
This action writes (downloads) the modified configuration to the PDR8000.

Procedure:
1. Perform changes to the parameters of the uploaded personality data.

NOTE: All changes to the parameters are indicated as follows:
Valid Changes

If any of the parameters within FRC are modified from its original value, the modified fields

are shaded in green. In addition, the EEPROM maintenance icon flashes yellow , and
when hovering over it, a message indicates EEprom Changed.

Invalid Changes
If any invalid changes are made, the modified fields are shaded in red. In addition, the

EEPROM maintenance icon flashes red  and the configuration windows containing
conflicting data is marked with a red exclamation mark on the FRC navigation tree.
The changes cannot be written to the PDR8000 until the errors are eliminated.

2. To save data changes to the PDR8000, perform one of the following options:
● From the menu bar, select PDR → Save Changes to PDR8000, or press shortcut key F4.
● From the menu bar, select PDR → EEprom Maintenance, or press shortcut key Ctrl + E. Select

Changes ➜ Repeater.

● On the FRC navigation tree, click on  and select Changes ➜ Repeater.
3. To ensure that the changes take effect, reset the repeater. Perform one of the following options:

● From the menu bar, select PDR → Reset PDR8000, or press shortcut key F3.
● From the menu bar, select PDR → EEprom Maintenance, or press shortcut key Ctrl + E. Select

Reset Repeater.

1.2.6

Creating a Support Package
Support Packages are standard support files required for the Support team to debug repeater issues.

Procedure:
To create a Support Package, from the FRC Menu Bar, select Options → Create Support Package.

Result: FRC takes over and creates the standard support package that includes the following support files:
1. EPR file
2. DPD file
3. Com Port Trace
4. App Log Trace
When saving all FRC support files is completed, an additional compressed file will be created:
SN_SP_Timestamp_SupportPackage.gz.
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1.3

FRC Offline Editing
FRC offline editing allows you to view, modify, and save new personality templates (DPD) files.

1.3.1

Viewing PDR8000 Personality Files Offline
Prerequisites: Launch the FRC.

Procedure:
1. Select File → Templates (DPD Files) → Load DPD Template.
2. Navigate to the file location, and click Open.
3. If the file was previously saved using custom encryption, enter the corresponding password to

continue.

1.3.2

Modifying PDR8000 Personality Files Offline
Procedure:

On the loaded DPD file, review and modify the field values.

1.3.3

Saving PDR8000 Personality Files Offline
NOTE: After the PDR8000 is programmed as per the needed requirements and the unit has been
tested successfully with this template, it is recommended to save the template as a DPD file on the
computer for future use.

Procedure:
1. To save the edited DPD file, select File → Templates (DPD Files) → Save DPD Template.
2. Navigate to the desired save location, specify filename, and click Save.
3. Fill in the fields in the Save window and click Save.
4. Select the desired Deployments to be saved, and click OK.
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5. Specify the encryption type and click OK.
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Chapter 2

PDR8000 Programming Guidelines
This section provides guidelines of Portable Digital Repeater (PDR) programming on the Futurecom
Repeater Configurator (FRC).

2.1

Programming Steps Overview
The PDR8000 operation depends on the following components:
● PDR8000 firmware and programming settings
● Subscriber Unit type, firmware, and programmed personality
● System infrastructure

2.2

PDR8000 Programming Information
The following provide detailed PDR8000 programming information.

IMPORTANT:
● Do not change PDR8000 settings unless fully familiar with the meaning of a specific option.
● The FRC program reports any obvious errors and does not allow invalid data to be saved to the

PDR8000. However, not all inconsistencies can be reported by the FRC. Successful PDR8000
programming requires a thorough understanding of the PDR8000 and PSU programming as well as
the specific User or System requirements. Only when all templates (PDR8000 and PSU) are
matched, the PDR8000 will operate properly.

2.3

FRC Window and Field Definitions
This section provides details to the fields available on the Futurecom Repeater Configurator (FRC).

Documentation Conventions
The following table provides information on conventions used throughout the document.

Table 9: FRC Conventions

Convention Description Examples

Window Name
→ Field Name

Used through field descriptions to refer
to a specific FRC field on a specific
FRC window.

Personality Information → Personal-
ity Name refers to the Personality
Name field located on the Personality
Information window.

Field Name con-
taining fields in-
dented under it

Field grouping or box title for a set of
fields logically grouped together on an
FRC window.

Personality Information → Date of
Programming is the group name for
the following fields:
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Convention Description Examples

● DAY
● MONTH
● YEAR

Range Valid values allowed for a field with
units of measurement (where appropri-
ate) and a default value identified where
the default value exists.

Display Unit → Timeout for Menu: 5–
60 (10) Seconds

Bold Text in
Range Column

Factory default value. Start-Up → BSI Interval: 1–60 (30) mi-
nutes
30 minutes is the default value.

<Italic> Field
Names

Fields displayed without a title or label.

Description Explains what the field represents and
provides details on each field value
where appropriate.

Frequency Band Configuration
→ Base Rx Frequency Indicates
the base receive frequency for this
PDR8000.

Notes Restrictions or limitations related to the
programming of the field; identifies de-
pendencies on other fields, or if a fea-
ture license is required.

Common Settings → Variable Fan
Variable Fan feature is only operational
with PDRs version 4 hardware and later.

Bolded feature li-
cense text

Feature license is required for this field
to be editable.

Field Name ✶ Model-specific fields.

Field Name ¤ Fields that are only applicable to the
connected PDR.
These fields will NOT be propagated to
another Repeater using a template file
(DPD).
These fields are grayed out during off-
line editing except for Hardware/Soft-
ware Information window.

General Configuration → DFSI
→ Fixed Station IP Address ¤

Field Name ¤§ Fields that are only applicable to the
connected PDR.
These fields will NOT be propagated to
another Repeater using a template file
(DPD).
These fields are grayed out during off-
line editing.

General Configuration → DFSI
→ Fixed Station Port ¤§

Field Name ● Fields that are only applicable to the
installed FRC and stored locally on its
PC.
These fields will NOT be propagated to
another Repeater using the template file
(DPD).

Ports → COM Port ●
COM Port setting specific to the version
of FRC installed on the PC.
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Convention Description Examples

Grayed Out (Disa-
bled) Fields

Grayed out fields cannot be edited.
Two scenarios exist:
1. Parameters displayed are ignored

by PDR either due to licensing, or
configuration of other fields.

2. Parameters displayed are fixed
based on PDR unit hardware or
software.

Examples:
1. Observed with V.24 Transmit Clock
2. Observed with Hardware/Software

Information

2.3.1

Setting Device Date and Time
This section sets the PDR8000 date and time of the connected PDR8000.

Prerequisites: Ensure that the PDR8000 is connected to the PC.

Procedure:
Perform one of the following options:
● From the FRC menu bar, select PDR → Set Device Date and Time.

● From the FRC navigation tree, click on  Set Date and Time.
Result: The Set Device Date and Time window opens.

describes the fields of the Set Device Date and Time menu.

Field Name Options/Units Description

PC Date and Time
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Field Name Options/Units Description

Date YYYY-MM-DD Displays the current PC date.
NOTE: Display only.

Time HH:MM:SS Displays the current PC time.
NOTE: Display only.

Time Zone Displays the Time Zone.
NOTE: Display only.

Daylight Saving Time
Active

● Yes
● No

Displays Daylight Saving Time.
NOTE: Display only.

Save PC Date and Time
to PDR

Saves the PC Date and Time to the PDR8000.

New Date and Time

Get Date and Time from
PC

YYYY-MM-DD Current Date and Time will be obtained from the PC
connected to the PDR.

NOTE: Can be changed manually.

Get Date and Time from
PDR

HH:MM:SS Obtain the current Date, Time, and Time Zone infor-
mation from the PDR8000 connected to the PC.

NOTE: Can be changed manually.

Time Zone Select world Time Zones from the dropdown menu.

Daylight Saving Time
Active

● Yes
● No

Enables or disable Daylight Saving Time.
NOTE: Adds one hour to the DST.

Save New Date and
Time to PDR

Save the Date and Time programmed in the New
Date and Time section to the PDR8000.
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2.3.2

COM Options
This section contains information for the elements under COM Options in the FRC navigation tree.

2.3.2.1
Ports
Figure 9: Ports Window

Field Name Range Description

COM Port ● N/A A drop-down list of available ports when connecting directly to
the PDR8000 USB Port.

NOTE: The save icon sets the selected COM port as
the default USB Port so it is the first port accessed for
any read/write operation.

2.3.3

PDR Configuration
This section contains information for the elements under PDR Configuration in the FRC navigation tree.

2.3.3.1
Frequency Band Configuration
The Frequency Band Configuration window is used for selecting the Adjacent Channel Separation.
There are three selections possible; Set 1, Set 2, and Set 3. Each of these sets can either be Narrowband
(12.5 kHz / 1.5 kHz), Wideband (25 kHz / 3 kHz), or NPSPAC (25 kHz / 4 kHz). Ensure the correct spacing
(Set 1, Set 2, or Set 3) is selected to match the portable radio programming on each PDR8000 channel. See
Bandwidth field in Channel Configuration on page 58.
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Figure 10: Frequency Band Configuration Window

Field Name Options/Units Description

Selected Frequency

RX Band MHz
● 136–174

(VHF)

Indicates the receiver band supported by the current
hardware platform.

NOTE: This field is read only.
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Field Name Options/Units Description

● 380–430
(UHF R1)

● 450–470
(UHF R2)

● 470–512
(UHF R3)

● 794–806
(700)

● 806–825
(800)

TX Band MHz
● 136–174

(VHF)
● 380–430

(UHF R1)
● 450–470

(UHF R2)
● 470–512

(UHF R3)
● 764–776

(700)
● 851–870

(800)

Indicates the transmitter band supported by the cur-
rent hardware platform.

NOTE: This field is read only.

Base Rx Frequency MHz Indicates the base receive frequency for the current
PDR8000.

NOTE: This field is read only. The value in
parentheses is the factory default value.

Max. Rx Frequency MHz Indicates the maximum receive frequency for the cur-
rent PDR8000.

NOTE: This field is read only. The value in
parentheses is the factory default value.

Base Tx Frequency MHz Indicates the minimum transmit frequency for the cur-
rent PDR8000.

NOTE: This field is read only. The value in
parentheses is the factory default value.

Max. Tx Frequency MHz Indicates the maximum transmit frequency for the
current PDR8000.

NOTE: This field is read only. The value in
parentheses is the factory default value.
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Field Name Options/Units Description

Channel-0 Base Frequency MHz Indicates the lowest frequency for the current
PDR8000, either transmit or receive.

NOTE: This field is read only. The value in
parentheses is the factory default value.

Adjacent Channel Offset/FM
Deviation

● Reserved
● 12.5

kHz/1.5
kHz

● 25 kHz
(NBPF) / 3
kHz

● 25 kHz / 4
kHz
(NPSPAC)

Offset indicates the width of each channel; used to
determine the frequency of the next channel.

Rx Synthesizer Frequency
Step

● 2.5000
kHz4

● 5.0000
kHz4

● 6.2500 kHz

Frequency step size used by the receive synthesizer.
NOTE: The value in parentheses is the facto-
ry default value.

Tx Synthesizer Frequency
Step

● 2.5000
kHz4

● 5.0000
kHz4

● 6.2500 kHz

Frequency step size used by the transmit synthesiz-
er.

NOTE: The value in parentheses is the facto-
ry default value.

Restore Factory Default Resets all the values to the factory preset values.

4 Valid for VHF only.

MN010432A01-AA
Chapter 2:  PDR8000 Programming Guidelines

39



2.3.3.2
Personality Information
The Personality Information window shows the information of the template.
Figure 11: Personality Information Window

Field Name Options/Units Description

Date of Programming

DAY Two (2) digits Indicates the day for the date of programming for this
personality template.

MONTH Two (2) digits Indicates the month for the date of programming for
this personality template.

YEAR Two (2) digits Indicates the year for the date of programming for
this personality template.

Personality Name Maximum 14
alphanumeric
characters

Name used to reference this personality template.

Personality Description Maximum 32
alphanumeric
characters

Descriptive text used to reference this personality
template.
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2.3.3.3
Hardware/Software Information
The Hardware/Software Information is for information purposes only. It displays information relating to the
Repeater Module and the IF Module, such as the repeater serial number, part numbers, revision or version
numbers, and release dates.
Figure 12: Hardware/Software Information Window

2.3.3.4
Common Settings
The Common Settings window is used for configuring deployments, choosing the desired channel, setting
password, and selecting the display unit menu. It also indicates if the V.24 or DFSI Wireline operation and
Deployment Profile Capability options are installed.
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Figure 13: Common Settings Window

Field Name Options/Units Description

V.24 Wireline Operation ● Enabled
● Disabled

Display if the V.24 Wireline Operation is enabled or
disabled.

NOTE: This is a read only field. Feature Li-
cense–V.24 Wireline Operation is required
to enable this feature. Refer to Ordering
Guides for order code.

Deployment Profiles Capabili-
ty

● Enabled
● Disabled

Display if the use of multiple deployment profiles is
enabled or disabled.

NOTE: This is a read only field. Feature Li-
cense–Deployment Profiles Capability is
required to enable this feature. Refer to Or-
dering Guides for order code.
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Field Name Options/Units Description

DFSI ● Enabled
● Disabled

Display if the DFSI Wireline Operation is enabled or
disabled.

NOTE: This is a read only field. Feature Li-
cense–DFSI Operation is required to enable
this feature. Refer to Ordering Guides for or-
der code.

Rackmount Booster ● Enabled
● Disabled

Rackmount PDR8000 only.
NOTE: This is a read only field. Feature Li-
cense is required to enable this feature. Re-
fer to Ordering Guides for more information
and order code.

Power up on Last Deploy-
ment

● Enabled
● Disabled

When Enabled
The PDR8000 powers up on the last active De-
ployment Profile.

NOTE: The channel within the deployment
profile that is active upon power up is de-
termined by configuration within the Gen-
eral Configuration window of that De-
ployment Profile.

When Disabled
The PDR8000 powers up on the deployment pro-
file configured in Start Up Deployment.

Start Up Deployment ● 1
● 2
● 3
● 4
● 5
● 6
● 7
● 8
● 9
● 10

Selects the Start Up Deployment.
NOTE: Not applicable if Power up on Last
Deployment is enabled.

Start on Last Active Channel
of Start Up Deployment

● Enabled
● Disabled

If enabled, the PDR8000 will switch to the last active
channel upon starting.

NOTE: Not applicable if Power up on Last
Deployment is enabled. In that case, the
channel activated at power up is determined
by configuration within the General Configu-
ration window of that Deployment Profile.

Startup Channel of Start Up
Deployment

1 to X
X denotes the
number of

Channel number of the Start Up Deployment on
which the PDR8000 shall start upon. Maximum chan-
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Field Name Options/Units Description

maximum
channels.

nel number is the highest channel configured in the
Start Up Deployment.

NOTE: Not applicable if Start on Last Ac-
tive Channel of Start Up Deployment is en-
abled. If Power up on Last Deployment is
enabled, then the channel activated at power
up is determined by configuration within the
General Configuration window of that De-
ployment Profile.

Variable Fan ● Enabled
● Disabled

Controls the speed of the internal cooling fans of the
suitcase PDR and Booster Pack.
When Enabled

Fan speed is automatically adjusted depending on
the internal temperature of the unit.

NOTE: The Variable Fan feature is only
operational with PDR version 4 hardware
and later. (Earlier hardware always runs
fans at full speed.)

When Disabled
Fans always run at full speed.

NOTE: Disabling this feature also disables
the PDR ability to query a suitcase Boos-
ter Pack for its RF Band information. This
prevents PDR from warning a user if a
nonmatching RF Band booster is connect-
ed to a PDR.

Time Zone UTC–05:00
(Eastern Time
(US and Cana-
da))
A drop-down
list consisting
of the world
time zone.

Select Time Zone from the drop-down menu.
NOTE: Follows the settings in Set Device
Date and Time. See Setting Device Date
and Time on page 34.

Daylight Saving Time Active ● Yes
● No

Enables or disables Daylight saving time.
NOTE: Follows the settings in Set Device
Date and Time. See Setting Device Date
and Time on page 34.

Configure Deployments Enables or disables Deployment Profiles as per the
PDR8000 Order. Any Deployment Profile can be cop-
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Field Name Options/Units Description

ied to any other Deployment Profile. Deployment Pro-
files can be reset to factory default.

NOTE:
● Opens a new window.
● Available only if Deployment Profile Ca-

pability is enabled.
● See Deployment Configuration on page

47.

Set Repeater Password Set the password for the PDR8000.

Reset Repeater Password Reset the PDR8000 password.

Display Unit ● Enabled
● Disabled

Enables functionality on the front panel keypad dis-
play.

NOTE:
● Only affects PDR units equipped with a

display unit.
● When disabled, the fields in Display Unit

are not configurable.

Keypad Lock Password Set the password to lock the keypad.
NOTE: See Keypad Lock Password on page
49.

Keypad Lock Timeout 0 minutes to 60
minutes
(OFF)

The keypad locks after the programmed time.

Menu Scroll RollOver ● Enabled
● Disabled

When enabled, the menu can be scrolled over on the
display.

Save Selected on Time-
out

● Enabled
● Disabled

When enabled, PDR saves any setting changed on
display unit when Timeout for Menu elapses.

NOTE: Settings can also be saved by press-
ing Select.

Keypad Beep ● Enabled
● Disabled

Enables or disables the keypad beeps.

Backlight Timeout 0 minutes to 60
minutes
(0 minutes)

The backlight turns off when the programmed time
runs out.

NOTE: The default setting is Always ON; the
timer can be set from 1–60 minutes. Enter
(0) to select Always ON.
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Field Name Options/Units Description

Timeout for Menu 5 seconds to
60 seconds
(10 seconds)

The menu display turns off when the programmed
time runs out.

NOTE: Save Selected on Timeout can be
configured to save selection after elapsed
time.

Deployments Menu ● Enabled
● Disabled

Enables or disable the Deployment menu on the Dis-
play panel.

Channels Menu ● Enabled
● Disabled

Enables or disable the Channels menu on the Dis-
play panel.

Time/Date Menu ● Enabled
● Disabled

Enables or disable the Time/Date menu on the Dis-
play panel.

User Language ● English
● French
● Spanish

Selects the preferred language.

Display Settings Upon button click, a new window opens to reset dis-
play contrast and brightness.
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2.3.3.4.1
Deployment Configuration
The Configure Deployment window configures the Deployment profiles as per the Order placed for
PDR8000.
Figure 14: Deployment Configuration Window

NOTE: The order of the deployment profiles can be rearranged by dragging and dropping up or down
within the list of deployment profiles.

Field Name Options/Units Description

Deployments order on the
PDR8000 Display

List of Deployment Profiles and their status.
NOTE: Enabled or disabled.

Deployment Information

Name Maximum 16
alphanumeric
characters

Name of the currently selected Deployment Profile.
NOTE: Do not use the underscore (_) in the
Deployment name as it will be displayed as a
space on the PDR8000 display.

Enabled Check box
(Enable/Disa-
ble)

Deployment Profile is enabled when the check box is
checked.

NOTE:
● Deployment status is displayed in the list

of Deployments.
● Deployment 1 is always enabled.
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Field Name Options/Units Description

Copy Deployment Copy the currently selected Deployment Profile con-
figuration to another Deployment Profile. A new win-
dow opens for selection of target Deployment Profile.

Reset Deployment Resets the currently selected Deployment Profile to
Factory default.

Reset Order Resets to factory order.

Update Deployments Update the Deployment Profiles as configured.

Close Close the Deployment Configuration window.
NOTE: If there are changes made but not
saved, prompts to confirm the changes made
to the Deployment Profiles before the win-
dow closes. See Change Confirmation
Prompts on page 48.

Change Confirmation Prompts
When Close is clicked and no modifications have been made to the Deployment Profile order or any
Deployment Profile name or enable status, the window will close. If any changes have been made, the
following prompt message pops up.

● Click Yes to apply the changes and close the Deployment Configuration window.
● Click No to discard the changes and close the Deployment Configuration window.
● Click Cancel to return back to the Deployment Configuration window.
When Yes is selected, a confirmation prompt appears. Click Yes in the confirmation window to apply the
changes to the Deployment Profile configuration.
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2.3.3.4.2
Keypad Lock Password
Clicking the Keypad Lock Password button on the Common Settings window opens a new window. The
Keypad Lock Password window allows you to set a password to lock the PDR8000 keypad.
Figure 15: Keypad Lock Password Window

Field Name Options/Units Description

Password 4 to 10 direc-
tional arrows

Select the sequence of the directional arrow signs (up,
down, left, right) from the drop-down menu to set the
password.

NOTE:
● The keypad password is unlocked using the

Arrow keys on the PDR8000 display panel.
● The duration between the key presses must

be less than 10 seconds.

Save Save the password to the PDR8000.

Clear Password Clears the password.

Close Close the Keypad Lock Password window.

2.3.4

Deployment Data Configuration
This section details the Deployment Data Configuration of PDR8000, including customization of configuration
parameters, use of Deployment Profiles, and the Futurecom Repeater Configurator (FRC) configuration
software. It explains how PDR8000 can be programmed with up to ten different Deployment Profiles, each
defining unique operational characteristics. The guide also covers the use of the FRC software to create new
Deployment Profiles and the supported interfaces for PDR8000.
PDR8000 is intended to be utilized in a variety of different scenarios, each supported by customizing
PDR8000 configuration parameters to match the needs of a given deployment. Since PDR8000 is intended
to be an easily redeployed unit, it offers an optional feature allowing multiple Deployment Profiles to be
preprogrammed. The desired preconfigured Deployment Profile is easily activated from the unit front panel
keypad/display.
With the Deployment Profile Capability enabled, PDR8000 can hold up to ten unique Deployment Profiles,
each defining the operational characteristics of the unit. This allows for preprovisioning with different
Deployment Profiles. For instance, one profile could be used when the unit operates as a Standalone
Repeater with specific frequencies, timings, and access codes. Another profile could be defined for
connecting the PDR8000 to a Motorola Solutions comparator or infrastructure core using a wireline link
and potentially different RF frequencies.
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Another convenient use of Deployment Profiles is to manage a PDR8000 that utilizes different physical
duplexers. Sometimes different duplexers have different values for Insertion Loss (Duplexer Transmit/Receive
Losses). The values for Duplexer Losses are configured into PDR8000 on a per Deployment Profile basis.
Therefore, when a duplexer is swapped into the PDR8000, the user can choose a Deployment Profile that
has been preconfigured with the Transmit/Receive Duplexer Loss values that correspond to the duplexer
being connected to the PDR8000 unit.
By utilizing the ten possible Deployment Profiles, PDR8000 can be ready to “pick up and go” for a large
number of common use case scenarios. The PDR8000 can be configured to power up to a specific
Deployment Profile or can power to the “last active” Deployment Profile. During field use, the active
Deployment Profile can be changed through the front-panel display.
The capability of the PDR8000 to store common configurations in its Deployment Profile set allows for the
use of temporary set-ups without overwriting frequently used ones.
The PDR8000 FRC configuration software enables the creation of new Deployment Profiles from scratch
or the modification of duplicated existing ones. This flexibility allows for operational adjustments when
requirements are similar but not identical.
The PDR8000 can be configured for ten different Deployment profiles. If the Deployment Profile Capability is
not purchased, PDR8000 can be programmed with a single set of configuration parameters. In this case, any
need to switch to a different set of operational parameters requires a PC running FRC to modify or load the
new set of configuration parameters into the PDR8000. See Table 10: Supported Interfaces for PDR8000 on
page 50 for supported Hardware Platform, Wireline Interface, Repeater Operation, and Channel Types.

Table 10: Supported Interfaces for PDR8000

Hardware Platform Wireline Interface Repeater Opera-
tion

Channel Type

PDR None Repeater Digital, Analog, and Mixed Chan-
nels

PDR V.24 Base or Repeater Digital Channels only

PDR DFSI Base or Repeater Digital, Analog, and Mixed Chan-
nels

Satellite Receive V.24 Base Digital Channels only

Satellite Transmit V.24 Base Digital Channels only

Each Deployment consists of General Configuration data and Channel Configuration as described in the
following sections.
High-Level categories of configuration parameters are:
● General Configuration
● Channel Configuration

2.3.4.1
General Configuration
The Deployment data is configured in the General Configuration window. The Deployment Profile can be
Enabled or Disabled. The PDR8000 Hardware platform can be specified.
Wireline or RT/RT mode is selected on this window. Many other general parameters pertaining to the specific
Deployment Profile can be programmed.
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Figure 16: General Configuration Window

Field Name Options/Units Description

Station Configuration

Deployment Name Maximum 16
alphanumeric
characters

Name of the current Deployment Profile.
NOTE: Do not use the underscore (_) in the
Deployment name as it will be displayed as a
space on the PDR8000 display.

Deployment ● Enabled
● Disabled

Enables or disables the Deployment Profile.

Station Name Maximum 31
alphanumeric
characters, ex-
cept for
_, ”, ?, ’, %, *,
and .

A unique name or alias that identifies the PDR8000.

Hardware Platform ● PDR
● Satellite Rx
● Satellite Tx

Identifies the hardware platform for this PDR8000.

System Type Conventional The supported system type is Conventional.
NOTE: This is a read-only field.

Site ID 1 to 62
(1)

When the Wireline Interface is set to V.24, this field is
used as the Terminal Endpoint Identifier number.

Wireline Configuration
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Field Name Options/Units Description

Wireline Interface ● None
● V.24
● DFSI

Select the wireline interface to be used.
NOTE: If None is selected, the other Wire-
line Configuration fields are disabled.

V.24 Transmit Clock ● Internal
● External

This specifies the source of the V.24 Transmit Clock.
This is needed for PDR8000 cross-connect (RT/RT)
and some modems.
Internal

The PDR8000 provides the clock. This choice is
typically selected when the radio is connected di-
rectly to an infrastructure device.

External
An external device (for example, a Modem) is pro-
viding the V.24 clock.

NOTE: This field is enabled when Wireline
Interface is set to V.24. Only available if the
V.24 license is purchased.

RT/RT Configuration ● Enabled
● Disabled

Enabled
PDR8000 used in RT/RT (back-to-back) configura-
tion.

Disabled
PDR8000 cannot be used in RT/RT configuration.

NOTE: This field is enabled when Wireline
Interface is set to V.24. Only available if the
V.24 license is purchased.

Packet Data

Repeat Packet Data ● Enabled
● Disabled

Enabled
Data is repeated locally.

Disabled
Data is sent to Infrastructure.

NOTE: Packet Data is not applicable to DFSI
deployments.

Wireline Data Drop Out
Delay

0 seconds to
255 seconds
(0 seconds)

Specifies the duration of the transmission of idle
packets following the transmission of an infrastruc-
ture originated data packet.

NOTE: A value of 0 means disabled.

In-Cabinet Repeat

Fallback In-Cabinet Re-
peat

● Disabled
● Link Failure
● Link Fail-

ure/Timer

Disabled
When the link failure is detected, the PDR8000
does not automatically activate its local repeat ca-
pabilities.
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Field Name Options/Units Description

Link Failure
When the link is disconnected, the PDR8000 auto-
matically activate its local repeat capabilities.

Link Failure/Timer
When the link is disconnected, or the Fallback
Determination Time expires, then the PDR8000
automatically activate its local repeat capabilities.

NOTE:
● This field is not applicable to channels in

Half Duplex or Simplex Mode.
● When Wireline Interface is set to None,

this field must be set to Disabled.

Fallback Determination
Time

50 ms to 10000
ms
(180 ms)

Amount of time the PDR8000 waits for an outbound
payload from the infrastructure after sending an in-
bound payload through the wireline interface.

NOTE:
● This timer is used when the Fallback In-

Cabinet Repeat is set to Link Failure/
Timer.

● This field is disregarded when Fallback
In-Cabinet Repeat is set to Disabled or
Link Failure.

Local PTT Test Tone Check box
(Enable/Disa-
ble)

Enabled
Pushing the Local PTT button transmits a 1 kHz
test tone on the active channel.

Disabled
Pushing the Local PTT button transmits an RF car-
rier on the active channel.

Repeater

Repeater Operation ● Base
● Repeater

Specifies whether a station is operating as a Base
mode or Repeater mode.
Repeater

Local repeat is available on Full Duplex channels
only (depending on Gate Parameters).

Base
Local repeat is unavailable (Full Duplex, Half Du-
plex, and Simplex are supported).

Repeater Gate Update ● Enabled
● Disabled

Specifies how the station determines its state after a
reset.
Enabled

The station comes up in the state last requested
by the console (Repeater Set Up or Repeater
Knocked Down).
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Field Name Options/Units Description

Disabled
The station comes up in the state specified by the
Repeater Gate Startup State field.

NOTE: Accessible only when Repeater Op-
eration is set to Repeater.

Repeater Gate Startup
State

● Knocked
Down

● Set Up

Specifies the station state after a reset, either Repeat
Set Up or Repeater Knocked Down.

NOTE: Accessible only when Repeater Op-
eration is set to Repeater AND Repeater
Gate Update is Disabled.

Start up

Start on Last Active
Channel

● Enabled
● Disabled

Specifies if the PDR8000 starts on the last active
channel after a reset.

Startup Channel 1 to 64
(1)

Specifies the channel to which PDR8000 is set after
a reset.

NOTE: Ignored when Startup on Last Ac-
tive Channel field is set to Enabled.

BSI Interval 1 minute to 60
minutes
(30 minutes)

Specifies the time interval at which the FCC assigned
station call sign is broadcast.

Astro Fade Tolerance 1 to 3 frames
(3 frames)

Specifies the number of missed frames before the
ASTRO message is considered terminated.

P25 Frame Sync Detection
Timer

30 ms to 255
ms
(100 ms)

Specifies for how long the PDR8000 digital decoder
waits for P25 digital signaling (Frame Sync) before it
assumes that the received signal is analog.

P25 Preamble Length 7.50 ms to
265.00 ms
(40 ms)

Specifies the duration of bit sync preamble packets
that are sent at the beginning of all ASTRO transmis-
sions.

RSSI

RSSI Off Hysteresis 2 dB to 20 dB
(5 dB)

Sets the Received Signal Strength Indicator (RSSI)
Off threshold in dB below the Received Signal
Strength On Threshold. See Channel Configuration
on page 58.

RSSI Speed 2 ms to 10 ms
(5 ms)

Sets the RSSI averaging integration time.

Squelch

Squelch Speed 10 ms to 150
ms
(25 ms)

Squelch Averaging Integration Time.
NOTE: Affects Analog Mode only.
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Field Name Options/Units Description

PL STE Duration 120 ms to 250
ms
(140 ms)

PL Squelch Tail Elimination Delay. Must be set to
match the portable setting.
The typical setting is 140 ms.

NOTE:
● Affects Analog Mode only.
● If this field is programmed too short, the

squelch tail will not be fully eliminated. If
it is programmed too long, the portable
may unmute unnecessarily.

FM Deviation

Audio Limit

12.5 kHz 0.75 kHz to
2.52 kHz
(2.12 kHz)

Typically set to 2.12 kHz (12.5 kHz channel spacing),
4.24 kHz (25 kHz channel spacing), or 3.39 kHz (25
kHz NPSPAC channel spacing).

NOTE:
● Affects Analog Mode only.
● Depends on the selected Channel Spac-

ing. See Frequency Band Configuration
on page 36 menu.

● Corresponding values for 25 kHz channel
spacing and NPSPAC are calculated
based on entry for 12.5 kHz channel
spacing.

25 kHz 1.5 kHz to 5.04
kHz
(4.24 kHz)

NPSPAC 1.20 kHz to
4.03 kHz
(3.39 kHz)

PL

12.5 kHz 0.19 kHz to
0.60 kHz
(0.38 kHz)

Typically set to 0.38 kHz (12.5 kHz channel spacing),
0.75 kHz (25 kHz channel spacing), or 0.60 kHz (25
kHz NPSPAC channel spacing).

NOTE:
● Affects Analog Mode only.
● Depends on the selected Channel Spac-

ing. See Frequency Band Configuration
on page 36 menu.

25 kHz 0.38 kHz to 1.2
kHz
(0.75 kHz)

NPSPAC 0.30 kHz to
0.96 kHz
(0.60 kHz)

DC Voltage Alarm Levels

Low Voltage Alarm ● 0 (Disa-
bled, dis-
played as
OFF)

● 10.0 V to
14.0 V

(11.6 V)

Voltage level that triggers the Low Battery Alarm.
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Field Name Options/Units Description

High-Voltage Alarm ● 0 (Disa-
bled, dis-
played as
OFF)

● 16.0 V to
17.0 V

(11.6 V)

Voltage level that triggers the DC Voltage High Alarm.

Temperature Alarm ● 0 (Disa-
bled, dis-
played as
OFF)

● 50°C to
100°C

(70°C)

PDR8000 activates the temperature alarm if the RF
transmitter module temperature exceeds this thresh-
old.

Output Power Alarm ● 0 (Disa-
bled, dis-
played as
OFF)

● 1 dB to 5
dB

PDR8000 activates the output power alarm if the dif-
ference in the measured RF transmit power and pro-
grammed transmit power exceeds this threshold.

NOTE: An alarm is indicated if the transmit
power level is too low. This could be caused
by limits of the PDR8000 hardware (per
product specification) compared to program-
med levels.

Antenna Switch
(Half - Duplex

● Enabled
● Disabled

Specifies whether the external antenna switch is
used for single antenna operation.

NOTE: Only accessible when Repeater Op-
eration is set to Base.

AFC

Fast ● Enabled
● Disabled

Enables or disables the Fast AFC.
NOTE: Set to Disabled during calibration.

Side LED ● Enabled
● Disabled

Enabled
Operational status can be viewed when the case is
closed.

Disabled
The LED is disabled.

NOTE: Applicable for PDR8000 Suitcase on-
ly. See the manual PDR8000 and Booster
Pack Deployment Guide for additional infor-
mation.

Duplexer Losses

Rx Duplexer Losses ¤ 0 dB to 3.0 dB
(*) Losses cor-
responding to

Displays the Rx Duplexer Losses.
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Field Name Options/Units Description

the Duplexer
shipped in the
PDR8000.

Allows the PDR8000 to compensate for the Receive
Signal losses due to the Duplexer.

NOTE:
● This field is preconfigured during produc-

tion of the PDR8000 and should only be
adjusted if or when the Duplexer con-
nected to the unit is changed or replaced.

● The values entered in this field should
match the RX IL value shown on the la-
bel affixed to each supplied duplexer.
See Figure 17: Duplexer Label (With
Identified Insertion Losses) on page 58.

Tx Duplexer Losses ¤ 0 dB to 3.0 dB
(*) Losses cor-
responding to
the Duplexer
shipped in the
PDR8000.

Displays the Tx Duplexer Losses.
Allows the PDR8000 to compensate for the Transmit
Signal losses due to the Duplexer.

NOTE:
● This field is preconfigured during produc-

tion of the PDR8000 and should only be
adjusted if or when the Duplexer con-
nected to the unit is changed or replaced.

● The values entered in this field should
match the TX IL value shown on the label
affixed to each supplied duplexer. See 
Figure 17: Duplexer Label (With Identi-
fied Insertion Losses) on page 58.

DFSI5

Fixed Station IP Address
¤

0.0.0.0 to
255.255.255.2
54

Standard IP address for the fixed station. This value
shall match what was programmed in the DFSI host
to connect to this station.

Fixed Station Port ¤§ 0 to 65535
(50006)

UDP Port at which the fixed station supplies the Con-
trol Service.

Control Retry Timer 200 ms to 2000
ms
(500 ms)
In 100 ms in-
crements.

Retry period for control messages.
This period shall be used for all control messages
except for Heartbeat and Acknowledgments.

Control Attempt Limit 1 to 10
(3)

Maximum number of attempts for control messages.
This number shall be used for all control messages
except for Heartbeat and Acknowledgments.

Connectivity Loss Limit 1 to 10 Maximum number of heartbeat losses to allow.

5 ● Only applicable if the DFSI license has been purchased.
● Fields in this group are applicable and editable only when Wireline Interface field is set to DFSI.
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Field Name Options/Units Description

(2)

DFSI IP Subnet ¤ 255.x.x.x The standard subnet mask, usually set to
255.255.255.0 for C-class network.

Fixed Station Voice Con-
veyance Port ¤§

2 to 65534
(51000)

UDP Port at which RTP traffic is conveyed to the
PDR8000. The port number shall be even.

NOTE: Even values only.

Figure 17: Duplexer Label (With Identified Insertion Losses)

2.3.4.2
Channel Configuration
The Channel Configuration window allows configuration of channels within each Deployment Profile.
The wireline interface to PDR8000 is a full-duplex link, able to send and receive information at the same time.
The RF configuration of the PDR8000 determines whether it can transmit and receive on the RF channel
simultaneously (full-duplex) or service only one side of the RF channel at a time (half-duplex).
This (Full/Half) Duplex mode is configurable on a per-channel basis.
Figure 18: Channel Configuration Window

Field Name Options/Units Description

Ch. # 1 to 64 Identifies the current channel as one of 64 possible
channels.

NOTE: This is a read-only field.

Enabled ● No
● Yes

Used to enable/disable channels.
NOTE: Ch1 must be enabled.
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Field Name Options/Units Description

Channel Name Maximum 16 al-
phanumeric
characters

A name that identifies the channel.
NOTE: Do not use the underscore (_) in the
Channel name as it will be displayed as a
space on the PDR8000 display.

Channel Type ● Analog
● Digital
● Mixed

Determines the PDR8000 Channel type.
NOTE: Analog and Mixed Channels are not
compatible with V.24 wireline operation.

Channel Mode ● F.Duplex
● Simplex
● H.Duplex

Determines the PDR8000 mode of operation for the cur-
rent channel; Full Duplex, Half Duplex, or Simplex.

NOTE:
Repeater Mode

Only Full Duplex Channels are allowed.
Base Station Mode

Full Duplex, Half Duplex, or Simplex chan-
nels are allowed.

Rx Freq. (MHz) MHz Receive the frequency for the current channel.
NOTE:
● When Hardware Platform is set to Satellite

Tx or channel mode to Simplex, this field is
read only and is disregarded.

● Must equal Channel-0 Base Frequency plus
an integer multiple of Channel No. Spacing
as defined in Frequency Band Configura-
tion window.

● Must also match the subscriber unit Trans-
mit Frequency.

Tx Freq. (MHz) MHz Transmit frequency for the current channel.
NOTE:
● When Hardware Platform is set to Satellite

Rx, this field is read only and is disregard-
ed.

● Must correspond to Channel-0 Base Fre-
quency plus an integer multiple of Channel
No. Spacing as defined in Frequency Band
Configuration window.

● Must also match the subscriber unit Re-
ceive Frequency.
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Field Name Options/Units Description

Tx Pwr (dBm) 30 dBm to 43
dBm
(40 dBm)

Specifies the transmit power at the PDR8000 antenna
port.

NOTE:
● TX power levels are those desired at the

PDR8000 antenna port, either with or with-
out a duplexer. PDR8000 attempts to adjust
its transmit power level to compensate for
duplexer losses however, is limited to the
maximum output power of the transmitter.

● When Hardware Platform is set to Satellite
Rx, this field is read only and is disregard-
ed.

Tx Pwr (Watts) 1 Watts to 20
Watts
(10 Watts)

Specifies the transmit power at the PDR8000 antenna
port in Watts (W).

NOTE: This is a read-only field.

NAC Table Index 1 to 64 Identifies which of the 64 possible Access Code Tables
applies to the current channel.

NAC Code Table Link, Maximum
10 alphanumer-
ic characters

NOTE: This is a read-only field that displays the
name of the Access Code Table only when con-
figured in Astro NAC Assignments window
(Channel Configuration → NAC Code Table).
See Channel-Access Code Table ASTRO NAC
Assignments on page 62.

ANA Table 1 to 64 Identifies which of the 64 possible PL/DPL Tables ap-
plies to the current channel.

Analog Code Table Link, Maximum
10 alphanumer-
ic characters

Identifies by name and provides a link to open the
PL/DPL Code Table window (Channel Configuration
→ Analog Code Table) associated with the current
channel.

NOTE: This is a read-only field that displays the
name of the Analog Code Table only when con-
figured in PL/DPL Code Table window.

PTT Priority ● W>R
● R>W
● R=W

Specifies priority order of two types of PTT requests:
● W = Wireline
● R = Receive of the Repeater

NOTE:
W > R

Wireline has priority over Repeater.
R > W

Repeater Receive has priority over Wireline.
R = W

Repeater Receive and Wireline have equal
priority. Whichever occurs first takes and
maintains PTT control.
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Field Name Options/Units Description

RSSI Thresh. (dBm) –50 dBm to –
127 dBm
(–115 dBm)

The Received Signal Strength Indicator (RSSI) Thresh-
old specifies the signal level at the input of the
PDR8000, required to validate the signal.

NOTE: RSSI Threshold levels correspond to
the level at the PDR8000 antenna port.
PDR8000 attempts to compensate for duplexer
losses but is limited to the maximum receiver
sensitivity.

W.T.O.T. (sec) 0 seconds to
2550 seconds,
in increments of
10 seconds
(0 seconds, de-
picts Disabled,
and is displayed
as OFF)

The Wireline Time Out Timer specifies the maximum
amount of time the transmitter may be continuously acti-
vated through the wireline signal.

NOTE: Any value entered that is not an incre-
ment of 10 is rounded up to the next valid val-
ue.

R.T.O.T. (sec) 0 seconds to
2550 seconds,
in increments of
10 seconds
(0 seconds, de-
picts Disabled,
and is displayed
as OFF)

The Repeater Time Out Timer specifies the maximum
amount of time the repeater mode may be continuously
activated by the subscriber through the receiver.

NOTE: Any value entered that is not an incre-
ment of 10 is rounded up to the next valid val-
ue.

R.D.O.D. (sec) 0 seconds to
2550 seconds
(0 seconds)

The Repeater Drop Out Delay specifies the amount of
time the repeater mode is maintained following loss of
received signal.

NOTE: Repeater Drop Out Delay is also known
as hangtime.

Monitor Before Data Tx ● Disabled
● Enabled

Disabled
PDR8000 does not monitor or notify the infrastructure
of any cochannel users.

Enabled
PDR8000 monitors the Rx channel for cochannel
users and notifies the infrastructure.

NOTE: If a cochannel user is detected, the
PDR8000 will notify the infrastructure (wire-
line) every 5 seconds. The PDR8000 will not
transmit data once it receives this message.
When cochannel activity stops, the PDR8000
will again notify the infrastructure (wireline).
The PDR8000 will resume data transmission
once it receives this message.

Tx Inhibit ● Disabled
● Enabled

Disabled
PDR8000 transmits on the selected channel.
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Field Name Options/Units Description

Enabled
PDR8000 does not transmit if this field is enabled.

Base Station ID Maximum 20 al-
phanumeric
characters (up-
percase letters
only)

Used for automatic, periodic, over-the-air transmission
of the PDR8000 call sign.
If the field is empty, BSID will not be transmitted.

NOTE: Assigned on a per channel basis, allow-
ing preconfiguration of different call signs on
channels that are used for different geographi-
cal deployments.

Sq. On Tr 4 dB SINAD to
28 dB SINAD
(16 dB SINAD)

Squelch ON Threshold.
NOTE: When Trigger is selected as Squelch.

Sq. Off Tr 3 dB SINAD to
25 dB SINAD
(10 dB SINAD)

Squelch OFF Threshold.
NOTE: When Trigger is selected as Squelch.

ON/OFF Trigger ● RSSI
● Squelch
● Sq&RSSI

Analog Mode
Any ON/OFF trigger can be selected.

Digital Mode
Only RSSI is allowed.

Mixed Mode
Only RSSI is allowed.

NOTE: Squelch is an invalid setting in Digital or
Mixed Mode PDR8000 Channels.

Bandwidth ● Set 1
● Set 2
● Set 3

Selects the FM channel bandwidth (12.5 kHz, 25 kHz,
or NPSPAC) as programmed in the Frequency Band
Configuration window.

NOTE: See Frequency Band Configuration on
page 36.

2.3.4.2.1
Channel-Access Code Table ASTRO NAC Assignments
In the Channel Configuration, the NAC Code Table allows the user to configure NAC Assignment Table
associated with that channel.

The Network Access Code or NAC is a feature of Project 25 digital radios that operates similarly to PL/DPL
codes for analog radios. NAC codes minimize cochannel interference and allow repeater addressing by
keeping the receiver squelched unless a signal with a matching NAC arrives. NACs are programmed as a
3-digit hexadecimal code that is broadcast along with the digital signal (Voice, Data, or Supplementary Data)
being transmitted.
Since the NAC is a 3-digit hexadecimal number (12 bits), it gives 4096 possible NACs for programming.
Three of these NACs have special meaning:
$293

The default NAC.
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$F7E
Receiver Monitor; a receiver set for this NAC will unsquelch on any NAC received.

$F7F
Community Repeater; a repeater receiver set for this NAC will allow all incoming signals to be repeated
with the NAC intact.

PDR8000 allows each of its digital-enabled channels to be configured with a desired behavior for utilizing
NACs. These behaviors are captured in NAC Code Table. Each configured channel in the PDR8000 can
point to one of the configured Access Code Tables. Each Access Code Table can be used to define NAC
operation for a specific channel or may capture behavior shared by multiple channels.
The Channel-Access Code Table ASTRO NAC Assignments Table excerpt is shown as follow with the
description of each field in the following table.
Figure 19: ASTRO NAC Assignments Window

Field Name Options/Units Description

Channel 1 to 64 Chan-
nels

Identifies the name of the channel for the current Ac-
cess Code Table.
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Field Name Options/Units Description

< Prev.CH 1 to 64 Go to the previous Channel by moving backward.
NOTE: Changes the Access Code Table ac-
cordingly.

Next CH > 1 to 64 Go to the next Channel by moving forward.
NOTE: Changes the Access Code Table ac-
cordingly.

Access Code Table Name Maximum 10
alphanumeric
characters

The name that identifies the current Access Code
Table.

< Prev.Tbl 1 to 64 Go to the previous Access Code Table by moving
backward.

Next Tbl > 1 to 64 Go to the next Access Code Table by moving for-
ward.

Channels Using This Table: 1 to 64, with
comma to sep-
arate the list of
numbers

List of PDR8000 channel numbers that use the cur-
rent Access Code Table.

NOTE: This is a read-only field.

Configuration

Rx NAC Operation ● Normal
● Receiver

Monitor
$F7E

● Community
Repeater
$F7F

● Multi NAC

Controls the mode of received Network Access Code
operation.
Normal

Receiver operation allows PDR8000 to accept in-
coming RF frames containing a specific NAC value
as defined by the Rx NAC field in the first row of
the Multi NAC table. Repeater and console calls
are transmitted using the Tx NAC field value as
defined in the first row of the Multi NAC table.

Receiver Monitor $F7E
Receiver operation allows a PDR8000 to accept
incoming RF frames containing any NAC value.
Repeater and console calls are transmitted using
the same fixed NAC.

Community Repeater $F7F
Community Repeater operation allows a PDR8000
to accept incoming RF frames containing any NAC
value. ASTRO packets are repeated with the same
NAC that was received by the incoming transmis-
sion. Infrastructure packets are transmitted using a
fixed Tx NAC.

Multi NAC
Multicoded squelch allows you to predefine a set
of accepted Rx NAC and associated Tx NAC being
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Field Name Options/Units Description

used by repeat and infrastructure calls. (Requires
Multi Coded Squelch enabled.)

NOTE: A DFSI-connected console may uti-
lize this functionality by specifying Tx NAC of
$F7E, or may override this behavior by pro-
viding a specific Tx NAC as part of the trans-
mission information.

Tx NAC Selected by
Last Received Rx NAC

● Enabled
● Disabled

Specifies how Tx NAC is selected for transmitting the
infrastructure audio.
Enabled

When the Tx NAC Selected by Last Rx NAC
Duration has not expired, the Tx NAC is selected
according to the following rules:
● For Multi-NAC operation, Tx NAC is set to the

programmed Tx NAC from the row in the Multi-
NAC table where Rx NAC is equal to the last
received Rx NAC.

● For $F7E and $F7F, Tx NAC is set to the last
received Rx NAC.

When the Tx NAC Selected by Last Rx NAC
Duration has expired, the Tx NAC is set to the
programmed Tx NAC from the first enabled row in
the Multi-NAC table.

Disabled
The Tx NAC is set to the programmed Tx NAC
from the first enabled row in the Multi-NAC table.

NOTE: A DFSI-connected console may uti-
lize this functionality by specifying Tx NAC of
$F7E, or may override this behavior by pro-
viding a specific Tx NAC as part of the trans-
mission information.

Tx NAC selected by Last
Rx NAC Duration

1 min to 30
mins
(5 mins)

Defines how long the last Rx NAC is used for trans-
missions after the last received call. Each received
call restarts the timer.

NOTE:
● This field is accessible only when Tx

NAC Selected By Last Rx NAC is Ena-
bled.

● A DFSI-connected console may utilize
this functionality by specifying Tx NAC of
$F7E, or may override this behavior by
providing a specific Tx NAC as part of
the transmission information.
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Field Name Options/Units Description

Multi-NAC Table Maximum 8
pairs

Defines up to eight (8) Rx and Tx Network Access
Code pairs for the specified Access Code Table.

NOTE: If Rx NAC Operation is set to Multi
NAC, all rows in the Multi-NAC Table are ac-
cessible. If Rx NAC Operation is not set to
Multi NAC, only the first row in the Multi-
NAC Table is accessible.

Enabled Check box
(Enable/Disa-
ble)

Identifies if the current row of the table is enabled for
use.

Rx NAC (hex) 000 to FFF
(293)

Defines the receive ASTRO Network ID.

Tx NAC (hex) 000 to FFF
(293)

Defines the transmit ASTRO Network ID.

Delete Pressing this button deletes all entries in this row of
the table and shifts all rows beneath up by one row.

Error report: Displays any warnings or errors related to the crea-
tion of Rx or Tx NAC pairs in the Multi-NAC table.

Apply ACT # <xx> to CH #
<yy>

Clicking on this button applies the NAC values Ac-
cess Code Table <xx> to Channel <yy> in the Chan-
nel Configuration Channel <yy>.

Update Access Code Table #
<xx>

Updates the Access Code Table <xx> in the Chan-
nel Configuration

Exit Exits the NAC Code Table.

Within each digital Access Code Table is a setting for the Rx NAC Operation mode to be utilized by channels
pointing to this table. The four modes of Rx NAC Operation are:
1. Normal
2. Receiver Monitor $F7E
3. Community Repeater $F7F
4. Multi NAC
Within each digital Access Code Table, a Multi NAC Table defining the NAC values is used to govern
squelch operation on the configured channel. The table consists of eight rows, having an Rx NAC and
corresponding Tx NAC value (each value 0 to $FFF). In most cases, only one row of values is used. If the
configured Rx NAC Operation operation is selected for Multi NAC; then all eight rows are available for use
(each row can be enabled/disabled for use in configuration.)
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2.3.4.2.2
Analog Code Table: Multi-Coded Squelch (PL/DPL)
Multi-Coded Squelch is a feature commonly used in analog radio operation. Operation is driven by the
addition of a subaudible tone on the RF carrier in addition to the voice payload.

When an RF signal is received, the receiver checks for the presence of PL/DPL, and modifies its behavior
based upon detection of the decoded PL/DPL tones. In most cases, the receiving radio will choose to either
unsquelch, or mute the incoming signal based on the presence of the detected PL/DPL.
PDR8000 allows each of its analog-enabled channels to be configured with a desired behavior for utilizing
PLs/DPLs. These behaviors are captured in Analog Code Tables. Each configured channel in the PDR8000
can point to one of the configured Analog Code tables. Each table can be used to define PL/DPL operation
for a specific channel or capture behavior shared by multiple channels.
Within each Analog Code Table, exists a Multi-PL/DPL table defining the PL/DPL values used to govern
squelch code on the configured channel. The table consists of 14 rows, having an Rx Squelch Code, a
corresponding Tx Squelch Code, as well as parameters to control Squelch Tail Elimination. In most cases,
the table is configured for Normal operation, allowing only the first row of the table to be used (see Table 11:
Analog Code Table on page 67). If, however, the table is configured for Multi-PL/DPL operation (see Figure
20: Multi-Coded Squelch (PL/DPL) Code Table Window on page 69) then all 14 rows are available for use
(each row can then be individually enabled or disabled as desired.)
Rx PL Operation:
● Normal
● Multi-PL/DPL

Table 11: Analog Code Table

Row
Ena-
bled

Rx Squelch Tail Elimination
(STE)

Rx
Squelch
Code

Tx Squelch
Code

Tx Squelch Tail Elimination
(STE)

Y/N Off / DPL / –135 / +135 / 180 Rx Code 1 Tx Code 1 Off / DPL / –135 / +135 / 180

Y/N Off / DPL / –135 / +135 / 180 Rx Code 2 Tx Code 2 Off / DPL / –135 / +135 / 180

Y/N Off / DPL / –135 / +135 / 180 Rx Code 3 Tx Code 3 Off / DPL / –135 / +135 / 180

Y/N Off / DPL / –135 / +135 / 180 Rx Code 4 Tx Code 4 Off / DPL / –135 / +135 / 180

Y/N Off / DPL / –135 / +135 / 180 Rx Code 5 Tx Code 5 Off / DPL / –135 / +135 / 180

Y/N Off / DPL / –135 / +135 / 180 Rx Code 6 Tx Code 6 Off / DPL / –135 / +135 / 180

Y/N Off / DPL / –135 / +135 / 180 Rx Code 7 Tx Code 7 Off / DPL / –135 / +135 / 180

Y/N Off / DPL / –135 / +135 / 180 Rx Code 8 Tx Code 8 Off / DPL / –135 / +135 / 180

Y/N Off / DPL / –135 / +135 / 180 Rx Code 9 Tx Code 9 Off / DPL / –135 / +135 / 180

Y/N Off / DPL / –135 / +135 / 180 Rx Code 10 Tx Code 10 Off / DPL / –135 / +135 / 180

Y/N Off / DPL / –135 / +135 / 180 Rx Code 11 Tx Code 11 Off / DPL / –135 / +135 / 180

Y/N Off / DPL / –135 / +135 / 180 Rx Code 12 Tx Code 12 Off / DPL / –135 / +135 / 180

Y/N Off / DPL / –135 / +135 / 180 Rx Code 13 Tx Code 13 Off / DPL / –135 / +135 / 180

Y/N Off / DPL / –135 / +135 / 180 Rx Code 14 Tx Code 14 Off / DPL / –135 / +135 / 180

PL and DPL codes are predefined in a common way, to allow use across radios manufactured by multiple
vendors. The Rx and Tx squelch code entries in the table can be set to a defined PL Code, a defined DPL
Code, or set to OFF (Carrier Squelch operation).
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Squelch Tail Elimination is a method used to prevent the receiving radio from hearing a brief noise (squelch
tail) at the end of each transmission. By having the transmitter provide a phase-shifted signal (for PL), or
a specific tone (for DPL), the receiver can quickly detect the end of the transmitted signal and mute the
unwanted noise. When PL is used, Tx STE and Rx STE can be set to Off, –135° phase shift, +135° phase
shift, or 180° phase shift. When DPL is used, Tx STE and Rx STE can be set to either Off or DPL (enabled).

Multi-Coded Squelch: Normal (Multi-PL/DPL Not Enabled)
If the active PDR8000 channel is configured to use an Analog Code Table for Normal PL/DPL operation, then
the first row of the PL/DPL table is enabled. That row defines the Tx and Rx behavior associated with all
traffic on the channel.
The PDR8000 only processes analog signals received over the air with PL or DPL that is equal to the Rx
PL/DPL code entry found in the first row of the table. In the first row, if the Rx Squelch Code is set to
OFF (Carrier Squelch), then all received signals on that channel that meet the Signal Strength and/or Signal
Quality criteria defined for this channel are processed by the PDR8000 (for example, no PL/DPL filtering is
done). Received signals not meeting the strength/quality criteria are ignored. PDR8000 Rx STE should be set
to match the Tx STE sent by the subscriber units.
When the PDR8000 sends a transmission, it encodes the Tx Squelch Code configured in the first row of the
Analog Code table. At the end of the transmission, PDR8000 can be configured to send a configured STE
(Squelch Tail Elimination) signal to help receiving radios quickly mute at the end of the transmission. The
configuration for Tx STE should be set to match the Rx STE expected by the subscriber units.

Multi-Coded Squelch: Multi-PL/DPL
If the active PDR8000 channel is configured to use an Analog Code Table configured for Multi-PL/DPL
operation, then the PDR8000 utilizes the full table to define filtering and translation. The PDR8000 only
processes analog signals received over the air with PL or DPL that is equal to any of the Rx PL/DPL code
entries found in any enabled row of the table. Rx STE od the PDR8000 in that row of the table should be set
to match the Tx STE sent by the subscriber units.
When the PDR8000 repeats an over-the-air analog transmission, it encodes the Tx PL/DPL found in the
same table row as the received signal Rx PL/DPL. At the end of the transmission, PDR8000 can be
configured to send a configured STE (Squelch Tail Elimination) signal to help receiving radios quickly mute at
the end of the transmission. The configuration for Tx STE should be set to match the Rx STE expected by the
subscriber units.
The Analog Code Table when clicked opens the PL/DPL Code Table for current Deployment. Table excerpt is
shown as follow with the description of each field in the following table.
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Figure 20: Multi-Coded Squelch (PL/DPL) Code Table Window

Field Name Options/Units Description

Channel 1 to 64 Chan-
nels

Identifies the name of the channel for the current An-
alog Code Table.

< Prev.CH 1 to 64 Go to the previous Channel by moving backward.
NOTE: Changes the Analog Code Table ac-
cordingly.

Next CH > 1 to 64 Go to the next Channel by moving forward.
NOTE: Changes the Analog Code Table ac-
cordingly.
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Field Name Options/Units Description

PL/DPL Code Table Name Maximum 10
alphanumeric
characters

The name that identifies the current Analog Code
Table.

< Prev.Tbl 1 to 64 Go to the previous Analog Code Table by moving
backward.

Next Tbl > 1 to 64 Go to the next Analog Code Table by moving forward.

Channels Using This Table: 1 to 64, with
comma to sep-
arate the list of
numbers

List of PDR8000 channel numbers that use the cur-
rent Analog Code Table.

NOTE: This is a read-only field.

Configuration

Multi PL/DPL ● Enabled
● Disabled

Multicoded squelch allows you to predefine a set of
accepted Rx PL/DPL and associated Tx PL/DPL be-
ing used by repeat calls.
Enabled

Receiver operation allows PDR8000 to accept in-
coming RF signal containing a specific PL/DPL
value as defined by the Rx PL/DPL field in all the
14 rows if Enabled in the PL/DPL table. Repeater
calls are transmitted using the Tx PL/DPL field val-
ue as defined in the PL/DPL table.

Disabled
Receiver operation allows PDR8000 to accept in-
coming RF signal containing a specific PL/DPL
value as defined by the Rx PL/DPL field in the first
row of the PL/DPL table. Repeater calls are trans-
mitted using the Tx PL/DPL field value as defined
in the first row of the PL/DPL table.

Tx PL/DPL Selected
by Last Received Rx
PL/DPL

● Enabled
● Disabled

Specifies how Tx PL/DPL is selected for transmitting
the infrastructure audio when Multi-PL/DPL is ena-
bled.
Enabled

When the Tx PL/DPL Selected by Last Rx
PL/DPL Duration has not expired, the Tx PL/DPL
is set to the programmed Tx PL/DPL from the row
in the Multi-PL/DPL table, where Rx PL/DPL is
equal to the last received Rx PL/DPL.
When the Tx PL/DPL Selected by Last Rx
PL/DPL Duration has expired, the Tx PL/DPL is
set to the programmed Tx PL/DPL from the first
enabled row row in the Multi-PL/DPL table.

Disabled
The Tx PL/DPL is set to the programmed Tx
PL/DPL from the first enabled row in the Multi-
PL/DPL table.
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Field Name Options/Units Description

Tx PL/DPL selected by
Last Rx PL/DPL Dura-
tion

1 min to 30
mins
(5 mins)

Defines how long the last Rx PL/DPL is used for
transmissions after the last received call. Each re-
ceived call restarts the timer.

NOTE: This field is accessible only when Tx
PL/DPL Selected By Last Rx PL/DPL is
Enabled.

PL/DPL Table Maximum 14
pairs

Defines up to 14 Rx and Tx Network Access Code
pairs for the specified Analog Code Table.

NOTE: If Rx PL/DPL Operation is set to
Multi PL/DPL, all rows in the PL/DPL table
are accessible. If Rx PL/DPL Operation is
not set to Multi PL/DPL, only the first row in
the PL/DPL table is accessible.

Enabled Check box
(Enable/Disa-
ble)

Identifies if the current row of the table is enabled for
use.

Rx PL/DPL STE deg/DPL Analog PSU PL/DPL STE-Squelch Tail Elimination –
must be programmed to match the Tx squelch STE of
expected by subscriber units.

Rx PL/DPL PL
67.0 to
254.1

DPL
d-023 to
d-754

Defines receive PL/DPL.

Tx PL/DPL PL
67.0 to
254.1

DPL
d-023 to
d-754

Defines transmit PL/DPL.

Tx PL/DPL STE deg/DPL Analog PSU PL/DPL STE-Squelch Tail Elimination –
must be programmed to match the Rx squelch STE
of expected by subscriber units.

Delete Pressing this button deletes all entries in this row of
the table and shifts all rows beneath up by one row.

Error report: Displays any warnings or errors related to the crea-
tion of Rx or Tx PL/DPL pairs in the PL/DPL table.

Apply Table # <xx> to CH #
<yy>

Clicking on this button applies the NAC values Ana-
log Code Table <xx> to Channel <yy> in the Chan-
nel Configuration Channel <yy>.

Update Access Code Table #
<xx>

Updates the Analog Code Table <xx> in the Channel
Configuration

Exit Exits the PL/DPL Code Table.
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2.3.5

Service
The FRC Monitoring window is provided to assist the field technician with PDR8000 setup and
troubleshooting. The Monitoring window provides real-time indication of the RSSI level, RF Power, NAC,
PL/DPL detection, BER measurement, and display of Signal quality.
Note that the fields Squelch ON Thresh, Squelch OFF Thresh, RSSI ON Threshold may be temporarily
modified in the Monitoring window for "tuning" the PDR. However, leaving the Monitoring Screen will result
in reverting to the previously programmed or saved values.
The user must make permanent changes to these configuration values using the normal editing windows in
the FRC, not through the Monitoring window.

IMPORTANT: It must be noted that the Monitoring window application is not intended to replace the
use of properly calibrated test equipment in the field.
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2.3.5.1
Monitoring

Field Name Options/ Units Description

PDR Operating Mode ● Normal
● Service

Specifies the current mode of operation.
Normal

PDR8000 is operating as programmed.
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Field Name Options/ Units Description

Service
PDR8000 is operating with user-initiated PTT Tx
only.

NOTE:
● This field is user-configurable.
● When PDR8000 is operating in Service

mode, transmissions are initiated only by
using the front panel PTT button or the
PTT configurable field in this window.

PDR Status ● Active
● Idle

Displays the current PDR8000 status.
NOTE: This is a read-only field.

PTT ● PTT Off
● PTT On
● Carrier
● Test Tone
● V.52 Test

Pattern

PTT Off
End test transmission.

PTT On
Digital or Mixed Mode channel
Transmit silent frames using NAC = the configured
Tx NAC of the channel on the programmed Tx
Frequency of the channel.
Analog channel
Transmit using the first enabled PL/DPL of the
channel on the programmed Tx Frequency of the
channel.

Carrier
Transmit raw RF Carrier on the programmed Tx
Frequency of the channel.

Test Tone
Digital or Mixed Mode channel
Transmit 1011 Hz test tone using ID=1, Talkgroup
= 1, NAC = the configured Tx NAC of the channel
on the programmed Tx Frequency of the channel.
Analog channel
Transmit 1 kHz test tone using the first enabled
PL/DPL of the channel on the programmed Tx Fre-
quency of the channel.

V.52 Test Pattern
Transmit V.52 test pattern on the programmed Tx
Frequency of the channel.

NOTE: This field is user-configurable, only
available in Service mode.

Repeater State ● Repeat
(Set up)

● Repeat
(Knocked
Down)

Indicates the PDR8000 repeat or base operation sta-
tus.

NOTE: This is a read-only field.
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Field Name Options/ Units Description

● Base sta-
tion

Deployment ¤ 1 to 10 Identifies the current Deployment of the 10 possible
deployments.

Channel ¤ 1 to 64 Identifies the current channel of the 64 possible chan-
nels.

Toggle Gate Status ● Set Up
● Knocked

Down

Toggles the Repeater Gate Status between Set Up
and Knocked Down.

NOTE: PDR8000 must be configured as a
Repeater (Deployment → General Config-
uration → Repeater → Repeater Opera-
tion) and be configured to use a wireline in-
terface (Deployment → General Configura-
tion → Wireline Configuration → Wireline
Interface) to have this button enabled.

Receiver Activity

Rx State ● Idle
● Active

Specifies the Receiver Activity.

Rx Source ● Inbound
● Outbound

Displays if the PDR8000 is receiving from the Sub-
scriber or transmitting on V.24 Link.

Rx NAC Displays the received NAC from the Subscriber.

Rx PL/DPL Displays the received PL/DPL from the Subscriber.

TalkGroup Displays the Subscriber Talkgroup ID.

Subscriber ID (decimal) Displays the Subscriber ID in decimal format.

Signal Quality

Sig. Quality Metric ● Idle
● Active

Idle
Below the SINAD threshold.

Active
Above the SINAD threshold.

NOTE: This is a read-only field.

SINAD (dB) Equivalent dB SINAD value.
NOTE: This is a read-only field.
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Field Name Options/ Units Description

Squelch ON Thresh. ¤ 4 dB SINAD to
28 dB SINAD
(16 dB SINAD)

Sets the Squelch ON Threshold.
NOTE:
● Affects Analog Mode only.
● If this field is temporarily modified in

Monitoring window for "tuning" the PDR,
leaving the Monitoring window will result
in reverting to the previously program-
med or saved values.

Squelch OFF Thresh. ¤ 3 dB SINAD to
25 dB SINAD
(10 dB SINAD)

Sets the Squelch OFF Threshold.
NOTE:
● Affects Analog Mode only.
● If this field is temporarily modified in

Monitoring window for "tuning" the PDR,
leaving the Monitoring window will result
in reverting to the previously program-
med or saved values.

Temp (°C) Celsius PDR8000 internal temperature.
NOTE: This is a read-only field.

PA Temp (°C) Celsius RF Power Amplifier temperature.
NOTE: This is a read-only field.

DFSI

Host IP Address 0.0.0.0 Shows the IP Address of the DFSI Host.
NOTE: IPv4 address for the DFSI host. Pro-
vided to PDR8000 by the host when
PDR8000 wireline interface is set to DFSI.

Host Control Port Up to 65535 UDP Port at which the fixed station supplies the Con-
trol Service.

NOTE: Provided to PDR8000 by the host
when PDR8000 wireline interface is set to
DFSI.

Host Voice Port Up to 65535 UDP Port at which the fixed station supplies the
Voice communication.

NOTE: Provided to PDR8000 by the host
when PDR8000 wireline interface is set to
DFSI.

Heartbeat Period (sec) 5 to 55 Periodicity of Host Heartbeats at which the PDR8000
expects a heartbeat from the host.

NOTE: Provided to PDR8000 by the host
when PDR8000 wireline interface is set to
DFSI.
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Field Name Options/ Units Description

Transmitter Activity

Tx ● Idle
● Active

Specifies the Transmitter Activity.

Tx Source ● Inbound
● Outbound

Displays if the PDR8000 is receiving from the Sub-
scriber or transmitting from the wireline Link.

Tx NAC Displays the NAC transmitted to the Subscriber.

Tx PL/DPL Displays the PL/DPL transmitted to the Subscriber.

TalkGroup Displays the Talkgroup ID transmitted to the subscrib-
er.

Tx Power Alarm ● ---- (blank)
● Active

PDR8000 activates the Tx power alarm (Active) if
the difference in the measured RF Tx power and pro-
grammed Tx power exceeds the configured thresh-
old.

NOTE: An alarm is indicated if the transmit
power level is too low. This could be caused
by limits of the PDR8000 hardware (per
product specification) compared to program-
med levels.

RSSI

RSSI State ● Idle
● Active

Specifies the state of the Receiver.
NOTE: This is a read-only field.

RSSI (dBm) dBm Received signal strength in dBm.
NOTE: This is a read-only field.

RSSI (µV) µV Received signal strength in µV.
NOTE: This is a read-only field.

RSSI ON Threshold ¤ –127 dBm to –
50 dBm
(–115 dBm)

Sets the RSSI ON Threshold.
NOTE:
● If this field is temporarily modified in

Monitoring window for "tuning" the PDR,
leaving the Monitoring window will result
in reverting to the previously program-
med or saved values.

● The programmed RSSI Threshold level
corresponds to the level at the PDR8000
antenna port. PDR8000 attempts to com-
pensate for duplexer losses but is limited
to the maximum receiver sensitivity.

MN010432A01-AA
Chapter 2:  PDR8000 Programming Guidelines

77



Field Name Options/ Units Description

Synthesizer ● Locked
● Out of Lock

Current state of the Synthesizer.
NOTE: This is a read-only field.

DC Voltage ● Normal
● High
● Low

DC Voltage.
NOTE: This is a read-only field.

P25 Rx Modem Test

BER Rx Test ● NO
● YES

Bit Error Rate P25 Rx Modem Test control.
NOTE: This field is user-configurable, only
available in Service mode.

BER % Current Bit Error Rate.
NOTE: Available in Service mode only.

BERm % Mean Bit Error Rate.
NOTE: Available in Service mode only.

Infrastructure Activity

Link State ● Active
● Idle
● Fail
● NA

Current State of the Wireline Interface Link.
Active

Link is established with activity.
Idle

Link is established, no current activity.
Fail

Link is not established.
NA

Not applicable. PDR is not configured to use a
wireline link.

NOTE: This is a read-only field.

Link Type ● V.24
● DFSI

Current Link type.
NOTE: This is a read-only field.

Rx ● Idle
● Active

Specifies the receive Link Activity.
NOTE: This is a read-only field.

Tx ● Idle
● Active

Specifies the transmit Link Activity.
NOTE: This is a read-only field.
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Field Name Options/ Units Description

Packet Loss % Specifies the percentage of Packet loss over the
wireline interface.

NOTE: This is a read-only field.

Network Health ● Good
● Marginal
● Poor

Specified the Link Quality of the wireline interface.
NOTE: This is a read-only field.

RF Power

RF Pow. (dBm) dBm PDR8000 transmitting RF power in dBm.
NOTE:
● This is a read-only field.
● Indicates the programmed TX power lev-

el at the PDR8000 antenna port, either
with or without a duplexer. PDR8000 at-
tempts to adjust its power level to com-
pensate for duplexer losses, however, it
is limited to the maximum output power.

RF Pow. (W) W PDR8000 transmitting RF power in Watts.
NOTE: This is a read-only field.

Antenna Switch ● Normal
● Reverse

Current antenna switch position.
NOTE: This is a read-only field.

Booster Pack
NOTE:
● Fields in the Booster Pack group are populated only when the PDR8000 is connected to a

Booster Pack.
● Not applicable to Rackmount PDR8000 with 50 W PA option.

Booster Pack Connected ● ON
● OFF

ON
Booster Pack connected to the PDR8000.

OFF
Booster Pack is not connected.

NOTE: The PDR8000 detects the Booster
Pack when connected through the AUX Port.

Booster Pack State ACTIVE ● This is a read-only field.
● For Hardware Rel.4, the booster pack is connect-

ed and of matching frequency band.

Ambient Temperature
(°C)

Celsius Booster Pack Internal temperature.
NOTE: This is a read-only field.
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Field Name Options/ Units Description

Power Amplifier Temper-
ature (°C)

Celsius RF Power Amplifier temperature.
NOTE: This is a read-only field.

2.3.5.2
Logs and Reports

Option Description

Get Status Refreshes data.

Save Status Saves data as text file.

Latest Occurrence On Top When checked (default), items are listed with the most recent at the top.

Clear All Clears the contents.

2.3.5.2.1
Status Report
The Status Report is a summary of occurrences for errors, warnings, and events for the active session.

This information is reset when PDR is powered down.

2.3.5.2.2
Status Log
The Status Log is a chronological list of errors, warnings, and other activity for the active session. Each
occurrence of an activity will appear on a separate line.

This information is reset when PDR is powered down.
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2.3.5.2.3
Status EEPROM Log
The Status EEPROM Log displays errors, warnings, channel or deployment changes, and system status.

Data is kept until cleared, or until the log reaches its maximum size causing the earliest entries to be deleted.
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Chapter 3

Booster Pack
For those agencies using Mobile Radios in their system, the PDR8000 Portable Digital Repeater Booster
Pack can assist them with additional output power above the native PDR8000 transmit power. The Booster
Pack is available in VHF, UHF 380 MHz–430 MHz, UHF 450 MHz–470 MHz, 700 MHz, and 800 MHz bands.
It is housed in a separate suitcase, which is the same size as the PDR8000 suitcase.

NOTE: Booster Pack is not available for Rackmount PDR.

During operation of the PDR8000 in a Booster Pack configuration, the PDR8000 automatically detects the
presence of the Booster Pack and adjusts its operating parameters to be compatible with the Booster Pack,
providing a preduplexer output signal of 50 Watts.
Figure 21: PDR8000 and Booster Pack

Booster Pack (Open Lid) PDR8000 (Open Lid)

3.1

PDR8000 and Booster Pack Hardware
Configurations
Multiple RF hardware configurations of the PDR8000 and the Booster Pack are supported, using accessible
internal and external connection points to enable the desired configuration.
The following figures show the interconnection between the PDR8000 and the Booster pack. These figures
are also screened on the back of the removable top panel inside the PDR8000.
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Figure 22: Internal Duplexer and Booster Pack Hardware Configuration

Figure 23: Simplex PDR8000 and Booster Pack Hardware Configuration

PDR

RF OUT

RF IN

ANT

AUX N/C

RF IN

RF OUT

AUX

BOOSTER PACK

FEMALE-FEMALE ADAPTER

RF OUT TX

RF IN ANT

Figure 24: External Duplexer and Booster Pack Hardware Configuration

3.2

PDR8000 Operation with Booster Pack
The PDR8000 Tx Output Power is programmed for each individual channel in the Deployment → Channel
Configuration. The PDR8000 can be configured to transmit max 20 W (43 dBm) output power at its Antenna
Port.
When the Booster pack is connected to the PDR8000, the PDR8000 automatically detects the presence of
the Booster pack and adjusts its Output Tx Power on the selected channel to 1.75 W (32.5 dBm), to supply
a compatible signal to the Booster Pack. The RF output using a Booster pack is 50 W (47 dBm) when no
Duplexer is connected to the PDR8000.
When a Booster Pack is connected, the Tx Duplexer Losses configured in FRC are not compensated for,
since the Booster Pack transmits a constant power level. Therefore, with the duplexer connected, the power
at the PDR antenna port is the power at the PDR8000 RF Out port plus duplexer losses. For example, if the
Booster Pack output power is 45 dBm and the duplexer loss is –1.5 dB, the output power at the PDR8000
antenna port is 43.5 dBm.
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The following screenshots show the PDR8000 FRC Monitoring window that indicates the Tx RF Power with
and without the Booster pack connected to the PDR8000.
Monitoring Window with Booster Pack Not Connected and PDR8000 Not Transmitting

The Monitoring window indicates that the PDR8000 is not transmitting, and no Booster pack connected to
the PDR8000.
Figure 25: Monitoring Window with Booster Pack Not Connected and PDR8000 Not Transmitting

Monitoring Window with PDR8000 Transmitting but Booster Pack Not Connected
In the Monitoring window, select the PDR8000 Operating Mode as Service, PTT as PTT On. Observe
the RF Power in the Monitoring window. (The PDR8000 on Deployment 1, Channel DIG. Programmed
Tx Power 20 W (43 dBm).)
The Booster pack is still not connected to the PDR8000. The Booster pack State is OFF.
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Figure 26: Monitoring Window with PDR8000 Transmitting but Booster Pack Not Connected

Monitoring Window with Booster Pack Connected but PDR8000 Not Transmitting
The Booster Pack is now connected to the PDR8000 and powered up. The Monitoring window indicates
that the Booster pack is On and Active but the PDR8000 is not transmitting (PTT OFF).
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Figure 27: Monitoring Window with Booster Pack Connected but PDR8000 Not Transmitting

Monitoring Window with Booster Pack Connected and PDR8000 Transmitting
Select the PDR8000 Operating Mode as Service and PTT as PTT On. The Booster Pack is connected
and active. The RF power of the PDR8000 drops down to a figure between 1 W and 2 W (1.75 W) from
the programmed 20 W as displayed.
The Power measured at RF output of the Amplifier of the Booster pack will be 50 W.
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Figure 28: Monitoring Window with Booster Pack Connected and PDR8000 Transmitting
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Chapter 4

Troubleshooting
If the FRC PC has difficulty communicating with the PDR:

1. Ensure that only one instance of FRC is open.
2. Make a second attempt to read the PDR.
3. Reconnect the USB, by disconnecting and connecting, and wait a few seconds for the device to be

recognized. Proceed to read the PDR again.
4. Power-cycle the PDR by disconnecting and reconnecting the power cord. Wait for a few seconds until

the PDR is on and the USB connects, then try to read the PDR. If the device is not recognized or read
fails again, try power-cycling the PDR one more time.

5. If still unable to read, reboot the PC.
The cause of errors or warnings may be due to any of the following reasons:
● Improper PDR8000 Programming.
● PDR8000 Firmware upgrade is improperly done.

NOTE: Ensure that the PDR8000 is on the latest released Firmware.

There are three locations where the errors or warnings are displayed:
1. Front Panel LED
2. Side Panel LED
3. Alphanumeric Display
Figure 29: Front Panel LEDs
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Table 12: Front Panel LEDs Status

PDR8000 Sta-
tus

LED LED Status
(ON/OFF/
Flashing)

Action

Power Up ● Power LED
● DC/Battery LED

OFF Disconnect the power source and
replace the appropriate fuse.

Wireline Ena-
bled

● LINK TX LED
● LINK RX LED

Flashing Check the Wireline connection
and PDR8000 Deployment pro-
gramming.

Repeater Fall-
back Mode

Top-left Fallback LED ON Check Deployment programming.

Service Mode Top Center Status Warn-
ing LED

ON Check the Monitoring window, if
the PDR8000 is in Service mode.

Error Top-Right Error Status
LED

ON Indicates Errors in the PDR8000.
Error codes are displayed.

Table 13: Side Panel LED Status

LED Status Status Action

Slow Flash PDR8000 is operating, but un-
der an abnormal or warning
condition. This includes operat-
ing in Fallback In-Cabinet Re-
peat when the wireline link has
ceased communication.

See front panel LEDs, front pan-
el display, or technicians log for
further insight.

Fast Flash PDR8000 is not functioning. A
major error has occurred.

4.1

Error and Warning Codes
The following error and warning codes may be displayed on the PDR8000 display.

Error Codes Description

Major Error Codes

80000000 Incompatible BaseBand DSP code loaded

40000000 Incompatible Transceiver DSP code loaded

20000000 Invalid EEPROM repeater model data

10000000 Invalid EEPROM checksum (data corrupted, any block)

8000000 Invalid EEPROM MAP (bad index table)

4000000 Incompatible hardware detected

2000000 Invalid EEPROM data (BlockID not found)

1000000 Invalid data in options block
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Error Codes Description

Minor Error Codes

1000 Factory Calibration/Test Issue (CALIBRATION ERROR)

800 RF band mismatch (BOOSTER MISMATCH)

400 RTC Chip failure

200 Invalid deployment number (INVALID DEPLOYMENT)

100 Disabled Channel Selected (DISABLED CHANNEL)

80 IF board link down – V.24 programmed and needed

40 Low Battery alarm (LOW BATTERY ERROR)

20 Hi Battery alarm (HIGH BATTERY ERROR)

10 Invalid Customer Option Programmed (INVALID CONFIG)

8 Invalid or unprogrammed channels selected (INVALID CHANNEL)

4 Invalid channel block checksum

2 Invalid Tx frequency programmed (INVALID TX FREQ)

1 Invalid Rx frequency programmed (INVALID RX FREQ)

Warning Codes

1 Low Battery warning (LOW BATTERY WARN)

2 IF Board not connected – V.24 not programmed

4 Incompatible Baseband DSP

8 Incompatible Transceiver DSP

10 Temperature alarm on PA board (HIGH TEMPERATURE)

20 Tx Power alarm (Outside range) (LOW TX POWER)

40 Bad main EEPROM map data

80 Bad backup EEPROM map data

100 EE map version mismatch

200 Options mismatch (INVALID CHANNELS)

400 RTC battery failed/time invalid (DATE/TIME WARN)

800 PDR8000 fan control board failed (FAN CONTROL WARN)

RF Error Codes

8000 Baseband DSP alarm (failed to load/start)

4000 Transceiver DSP alarm (failed to load/start)

2000 Baseband DSP alarm (invalid checksum)

1000 Transceiver DSP alarm (invalid checksum)

800 Rx synthesizer lock alarm

400 Tx synthesizer lock alarm

Other Warnings

Packet Loss on V.24 or Ethernet (LOW QUALITY LINK)
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Error Codes Description

Unable to establish wireline connection (LINK FAILURE)
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Glossary
Acknowledgment (ACK)  A message sent in
response to another message to indicate status.

Booster Pack An optional hardware accessory
for PDR8000 to boost the RF transmit power to 50
W.

Base Station Identification (BSI) The
assigned station identification callsign issued for the
system by the local licensing authority. In the U.S.,
this is the Federal Communications Commission
(FCC) for non-federal government customers, and
the National Telecommunications and Information
Administration (NTIA) for government customers.

Channel  A group of characteristics, such as
transmit or receive frequency pair, radio parameters,
and potentially encryption encoding.

Coded Squelch  Tone Private-Line (PL) or
Digital Private-Line (DPL). Used on conventional
channels for signal validation.

Conventional  Refers to radio-to-radio
communications, sometimes through a Base Station
repeater or vehicular repeater. A radio system
operation that does not use a control channel. It
uses nontrunked telecommunications equipment.

Deployment Complete personality setup of the
PDR8000.

Digital Fixed Station Interface (DFSI)
An industry standard protocol for radio voice
communication over IP network between a host and
station.

Dispatcher  An individual who manages the radio
system.

DPD File  Personality file saved as
file_name.DPD.

DPL Coded Squelch  A continuous subaudible
data signal (CDCSS) transmitted with the carrier.

EPR File  File containing personality (DPD) and
calibration data of the specific repeater unit.
Typically saved in the following format
xxxxxxxx.epr where xxxxxxxx is the serial
number of the specific repeater unit.

Federal Communications Commission
(FCC)  Regulates interstate and international
communications by radio, television, wire, satellite
and cable in all 50 states, the District of Columbia,
and U.S. territories. It was established by the
Communications Act of 1934 and operates as an
independent U.S. government agency overseen
by Congress. The commission is committed to
being a responsive, efficient, and effective agency
capable of facing the technological and economic
opportunities of the new millennium.

Futurecom Repeater Configurator (FRC)
Programming software application for the DVR-LX®,
VRX1000, and PDR8000®.

Network Access Code (NAC)  Used in P25
mode for validation of P25 radio communications,
similar to the use of PL/DPL in analog mode.

Over-The-Air-Programming (OTAP)  An
ASTRO® 25 Integrated Voice and Data (IVD) service
for programming subscriber units over the ASTRO
25 IVD air interface.

PL Coded Squelch Private Line. A continuous
subaudible tone (CTCSS) transmitted with the
carrier.

Portable Subscriber Unit (PSU)  A portable
subscriber unit.

Radio Frequency (RF)  A portion of the
electromagnetic spectrum that resides between
audio sound and infrared light (approximately 10
kHz to 10 GHz).

Received Signal Strength Indicator
(RSSI)  A value that represents the power level in
a received radio signal strength measured in dBm.
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Talkgroup  A uniquely named group of radios that
can share calls and messages. A talkgroup normal
communications do not require interfacing with other
talkgroups. Typically, the majority communications
of a radio user are within their own talkgroup.

V.24 A digital link better described as a physical
V.24 link with High-level Data Link Control
(HDLC). Used to connect the PDR8000 to other
infrastructure elements (for example, CCGW, DIU,
comparator).

Talkgroup
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